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Plant Applications Installation Overview 

Introduction 

Plant Applications is a unique software solution that digitizes the collective information being 
generated throughout your production facilities into a “virtual plant” for access where, when, 
and how you need it. Plant Applications provides clear insight into your production to greatly 
improve operational effectiveness. 

Plant Applications continues to offer an SDK to customize and implement platform (MESCore) 
features. 

United Manufacturing Database Support 

Plant Applications continues support for the Unified Manufacturing Database (UMDB) that 
combines a Plant Applications data model with the S95 data model employed by 
the SOA platform. 

The model offers a single platform to implement holistic, operational performance-
management solutions for batch, discrete, and mixed environments using equipment, product, 
and people centric models. It provides the following benefits: 

• Extension by the new MESCore Service provider of the SOA data model to enable 
creation of a Unified Manufacturing Database. 

• Data entry through the convenient Workflow Client interface. A separate license 
for Workflow is required to use workflows. 

• Data methods to design custom displays and forms to gather, monitor, and analyze 
plant operations data. Using methods with Workflow requires a license. 

Licensing 

Plant Applications licensing has been simplified to help manage concurrent users. The Plant 
Applications Server is licensed based on the number of concurrent users that connect to the 
server. 

A concurrent user has access to all modules and functions in Plant Applications. You can license 
individual modules, supporting module-level licensing for customers having previous licensing 
for the Efficiency, Quality, and Production modules. 



A Workflow license is not required for Plant Applications. A separate Workflow license is 
required to create workflows or to use methods. 

After installing Plant Applications, you can use the License Viewer to help determine what 
licenses exist on a machine. From the Windows Start menu, select Programs > Proficy 
Common > License Viewer. 

For more information about the latest GE Digital product offerings, 
see https://www.ge.com/digital/products. For general information about the new GE Digital 
licensing model, search for Licensing information on https://digitalsupport.ge.com/. A help 
system is installed with licensing and is available from the Proficy Common directory. 

  

https://www.ge.com/digital/products
https://digitalsupport.ge.com/


Installing Plant Applications 

About Installing Plant Applications 

This section of the document describes how to get started with the installation of Plant 
Applications in the non-Docker environment. Ensure that you perform the following tasks for 
installing Plant Applications: 

• Software Requirements 

• Installing the .NET Framework 

• Setting up IIS Web Services 

• Removing WebDAV Publishing from IIS 

• Editing the ISAPI File Path 

• Workflow Requirements 

• SSL Security Certificates 

• Port Requirements 

• Before You Begin 

• SQL Server Requirements 

• Setting up the Remote Data Service 

• Upgrade Strategies 

• Database Setup Strategies 

• About TLS Support 

• About the SQL Server AlwaysOn Requirements 

• Installation Overview 

• Installing the Proficy Application Server 

• Binding HTTPS 

• Installing the Plant Applications Server 



• Installing the Plant Applications Client and Administrator 

• Data Authorization for Events Configured for Each Event Type 

• Installing the Plant Applications SDK 

• Installing the Plant Applications Message Bridge 

• Configuring a User in RabbitMQ 

• Installing the Plant Applications Universal Client 

• Task Lists for ActiveX and SOA Web Client 

• Preparing a SOA Database for UMDB Integration 

• Report Server Installation Overview 

• Windows Installation Limitations 

• IIS Metabase Configuration Backup 

• Setting Up Internet Explorer Security for Web Reports 

• Installing the Plant Applications Report Server 

• Setting Up the Plant Applications Report Server 

• Secure Socket Layer and Certificate Requirements 

• Setting Up IIS for Remote Use 

• Setting Up the Plant Applications Excel Add-In 

• Local Client Application Support 

• UTC Support 

• Upgrading Plant Applications to Use UTC 

• Setting Up Languages for Plant Applications Displays 

• Managing Port 12280 Conflicts 

• Security Modification for Proficy Plant Server 

• Database Purges 



• Customizing Your Application 

• Plant Applications Administrator 

• Plant Applications Client 

• Workflow Client 

• Plant Applications Report Server Administrator 

• Plant Applications Web Server Client 

• Web Part Administrator 

• Plant Applications REST APIs 

• Verifying Plant Applications Service Startup 

• Verifying the Server Connection 

• Changing the SharePoint Port Number 

• Backing Up and Restoring an SQL Database 

• Moving Database and Log Files 

• Proficy Router Conflicts 

• SQL Login Conflicts 

• Runtime Error 

• SQL Server Blockage 

• License Server Startup Failure 

• Web Content Issues 

• Web Reports Issues 

• Proficy Server Shutdown Error 

• Proficy Server Installation Script Failure 

• Database Connection Failure 

• License Manager Connection Failure 



• Proficy Workflow Client Startup Failure 

• Plant Applications Client or Administrator Failure 

Software Requirements 

Before you install Plant Applications, verify that all required software versions have been 
installed on the target machine. 

Workflow and Predix components are required for Plant Applications and installed from 
the Installation Menu. 

See Test and Production Environments to compare machine requirements in a test, standard 
production, and high-transaction environment. 

NOTE: 

 Plant Applications 7.0 SP1 does not support Web Client Displays for Vision, which were delivered in 

previous versions. 

• Windows Server 2019, 2016 or 2012 R2 for server installations (64-bit) 

• Windows 7 and Windows 10 for client installations (64-bit) 

• SQL Server 2017, 2016 (64-bit), 2014, and 2012 

Note: You must have SQL Server 2016 (64-bit) or later for the Docker based Universal 
Client installation. 

• Microsoft System CLR Types for Microsoft SQL Server 2016 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0 

• Microsoft .NET Framework 3.5 for Workflow 2.6 

NOTE: 

 You can download the Microsoft .NET Framework 4.7 from the following 
URL: https://go.microsoft.com/fwlink/?LinkId=825299 

• Internet Protocol Version 4 (IPv4) 

• Web Server IIS 8.0 or later based on the operating system 

• SQL Server 2012 Native Client version 11.4.7001.0 or later 

https://go.microsoft.com/fwlink/?LinkId=825299


NOTE: 

 The SQL Server 2012 Native Client is required for Plant Applications Server and Plant 
Applications Client machines. If the version of the SQL Server 2012 Native Client you installed 
is not 11.4.7001.0 or later, you must upgrade it. You can download the SQL Server 2012 
Native Client version 11.4.7001.0 or later from the following 
URL: https://www.microsoft.com/en-us/download/details.aspx?id=50402 

• Microsoft Excel 2019, 2016, or 2013 (required for SQL Server and Web Engines) 

NOTE: 

 If you import data using a Microsoft Excel file that was created in an older version, it will not 
contain the columns necessary to support the new Event Progress feature. Refer to topics in 
Plant Applications Help for steps describing how to use the Excel add-in. 

• Microsoft SharePoint Portal Server 

• Workflow 2.6 

NOTE: 

 You must install Workflow 2.6 if you are installing a clean environment of Plant Applications 

• Browsers 

• Microsoft Internet Explorer 11 (Web Reports) 

NOTE: 

 Currently, Plant Applications Universal Client components do not support Internet 
Explorer. 

• Chrome v65.0+ (Plant Applications Universal Client components) 

• Safari v10.0+ (Plant Applications Universal Client components) 

NOTE: 

 Process Analyzer only supports Chrome. 

• PDF reader (required to view some Web Server reports) 

Installing the .NET Framework 

You should install or upgrade to .NET Framework 4.7. 

1. Stop all SOA services, Plant Applications services, and SQL server services to prevent the 
.NET Framework 4.7 installation from rolling back. 

2. Download and install the .NET Framework 4.7 from the Microsoft product website. 

https://www.microsoft.com/en-us/download/details.aspx?id=50402


3. Use the Control Panel to verify Microsoft .NET Framework 4.7 is listed as an installed 
program. 

4. Restart the services. 

Setting up IIS Web Services 

NOTE: 

 Before you make any changes to Internet Information Services (IIS), you may want to export your 

existing configuration to review it. For more information on an existing Microsoft utility, refer 

to https://www.iis.net/learn/get-started/getting-started-with-iis/getting-started-with-appcmdexe 

Verify that all role services for Web Server and IIS have been installed. 

1. Open Server Manager. 

2. Expand Roles, then select Web Server (IIS). 

3. Scroll down in the information listed for the Web Server (IIS) to view installed Role Services, 
and verify that the correct services have been installed. 

4. If needed, click Add Roles in the Roles Services section to start the Add Role Services wizard 
to add a role. 

5. Click the Web Server (Installed) box to enable service selection. Restart the machine if role 
services have been added. 

6. Expand Features, and run the Add Features wizard. 

https://www.iis.net/learn/get-started/getting-started-with-iis/getting-started-with-appcmdexe


 

7. Select HTTP Activation under .NET Framework 3.5.1 Features, then run the wizard to install 
the feature. 

Removing WebDAV Publishing from IIS 

WebDAV Publishing causes an error when deleting or updating comments or events. When 
installing IIS, do not include WebDAV. 

If IIS is already installed with WebDAV, uninstall it from the Role Services screen of the Server Manager. 



 

Editing the ISAPI File Path 

An error can occur when loading ISAPI filters. 

1. Open Internet Information Services (IIS) Manager from the Server Manager, then right-click 
the icon to open the ISAPI Filters pane from the ISS section of the ISS Manager. 



 

2. Expand the Executable column and look for any executable path containing two backslashes 
instead of one. Right-click the executable and select Edit. 

 

3. Change the ISAPI Filter path to use a single slash, such as \aspnet_filter.dll as 
shown in the following example. 



 

4. Navigate to ISAPI and CGI Restrictions under IIS for the Report Server, then right-click to 
open the pane. 

 

5. Verify that the Framework and Framework64 extensions for ASP.NET, version 4.0.30919, are 
set to Allowed. Right-click an entry to make a change if necessary. 



 

Workflow Requirements 

The Proficy Application Server selection under Prerequisites in the Plant 
Applications Installation Menu installs Workflow 2.6 components. When upgrading, refer 
to Upgrading from Plant Applications Version 6.3 or 7.0 to 8.0. 

SOA Platform 

The SOA platform is installed along with Workflow and is required by Plant Applications to 
install the UMDB. A Workflow license is not required to use Plant Applications with the UMDB, 
but a Workflow license is required to build workflows. Plant Applicationssupports the 32-bit 
version of Workflow. 

NOTE: 

 Install or upgrade Workflow components before Plant Applications components. When upgrading, 

follow the steps in Upgrading from Plant Applications Version 6.3 or 7.0 to 8.0. to remove components 

before starting the installation. 

SSL Security Certificates 

The Proficy Application Server requires SSL security certificates. 

You can use self-signed certificates in intranet environments only. The certificates need to be 
trusted on each client machine that accesses the websites. Self-signed certificates are best used 



in demonstration environments, but not in enterprise or Internet deployments. You can use 
existing certificates deployed by your existing security policy or purchase new certificates. 

When installing the Proficy Application Server, you are prompted to generate new certificates, 
import certificates, or use legacy certificates. If you do not have a certificate, you will typically 
generate a new one. You can follow the instructions at technet.microsoft.com to create a self-
signed certificate for testing in an intranet environment. 

NOTE: 

 You need the fully-qualified domain or machine names when registering SSL security certificates.. They 

should be the same names that you provide when you define IIS and the HTTPS binding, and must match 

the name on the certificates (for example: MyComputer.MyDomain.com.. 

Port Requirements 

Use internal interfaces to open the ports required for Plant Applications operations. 

Port Description 

80 Used by Web server for serving traditional, web reports. 

1433 Used by SQL Server for communication to SQL. 

Use the CXS_Service table in the Plant Applications database to modify the following ports. 

Port Description 

12293 Used by Proficy Server Manager for the Service Control feature of the Administrator. 

12294 Used by Proficy Server Gateway for clients (including SDK) to send/receive Plant Application 

messages. 

http://technet.microsoft.com/


Port Description 

12295 Used by Proficy Server Gateway for clients (including SDK) to send/receive Plant Application 

messages. 

12295 Used by older (4.0 and older) versions of Client Manager. 

12299 Used by Proficy Server Remote Data Service, allowing Proficy services perform remote read 

and write operations to a historian. 

12401 Used by Proficy License Manager for licensing requests from Proficy services to clients. 

Use INI files such as cmRTR.ini, cmConfigMgr.ini, PlantAppsMessging.ini, 
or Message.ini(found in the Plant Applications program installation directories), to modify 

the following ports. 

Port Description 

10000 Used by the Proficy message router to process Plant Applications messages between services 

clients communicating with the router. 

12280 Used by the Proficy message router to process Plant Applications messages between services 

clients communicating with the router. 

Following ports are required for the Plant Applications Universal Client 



Port Description 

5672 Used by the Rabbit MQ Message bridge to communicate with the Plant Applicationsserver to 

retrieve data updates. 

8443 Used to provide the required redirect to allow the UAA to load the Universal Client. 

8444 Tomcat port used by the Universal Client. 

5433 Default port for PostgreSQL installation. 

Before You Begin 

Before you install Plant Applications, complete the tasks described in this section. 

Review Time Zone Settings 

Ensure that the system time and time zone of the server and client that you want to use 
for Plant Applications are correct and in sync. 

Review Architecture Requirements 

You must install a historian such as GE Digital Historian as well as prerequisite software such as 
SQL Server. Plant Applicationssupports Historian (standard or enterprise) 7.0. 

Due to the competition for ports, “all-in-one” deployments are no longer supported. We 
recommend that Historian and Universal Client be installed on separate server nodes. 

Refer to Test and Production Environments to learn about architecture strategies to meet the 
needs of particular environments. 



Review Upgrade References 

If you are upgrading from version 6.3 or 7.0 to 8.0 of Plant Applications, refer to Upgrading 
from Plant Applications Version 6.3 or 7.0 to 8.0 for additional steps. Contact GE Support 
at General Contact Information for assistance with upgrading from earlier versions. 

If you are installing the Plant Applications Server, Clients or Web Server report components in a 
clustered environment, review the information in Appendix B at Cluster Overview. 

If upgrading the Unified Manufacturing Database (UMDB), refer to these sections: 

• Upgrade Strategies gives strategies to upgrade the UMDB from previous versions. 

• Database Setup Strategies describes how to upgrade a SOA or Plant 
Applications database to a UMDB. 

• Setting Up Languages for Plant Applications Displays explains how to implement 
additional languages after installing Plant Applications. Plant Applications displays use 
English as the default language. 

System Requirements Location 

The Important Product Information (IPI) help file outlines system requirements, and can be 
accessed from the Installation Menu. 

Preparing for a UMDB Implementation 

The UMDB essentially combines the SOADB' database (S95 data model) and GBDB database (Plant 

Applications data model). You can choose to use only the Plant Applications data model by disabling 

UseProficyClient configuration parameter (ID 87). The following items are important to consider as a 

part of installation planning: 

• Strategy 

• Using the new, combined data model offered by the UMDB enables you to 
define a plant environment in an S95 structure while providing a strict and 
formal definition that was not possible with Plant Applications. Thus, it is 
advantageous to define all configuration information through the Client 
interface and to use Plant Applications for features that are unique to Plant 
Applications such as specifications, alarms, and downtime. 

https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/general-contact-information#concept_f39c7423-9ff1-46e8-9f90-e6afb1d4a595
https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/cluster-overview#concept_1d598f56-e09b-4f81-9658-1e67a50ff763
https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/upgrade-strategies#concept_02f276e3-d5e4-4faa-8cac-90db04c66cdb
https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/database-setup-strategies#concept_efbaf17e-aa51-43e9-94ff-ced3911a8449
https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/setting-up-languages-for-plant-applications-displays#task_fc137b53-1588-4ca7-a768-cecaf4eb51d9


• Although it may be helpful to configure some units in an S95 model, it may 
be practical to maintain the configuration of some units in Plant 
Applications. In this situation, it is important to carefully manage the 
configurations. Once data is extracted from Plant Applications to the S95 
model, it retains characteristics of the S95 model. If units are defined in 
both models, problems with orphans can arise. 

• See Working with a Merged System and UMDB in Plant Applications Help 
for a description of the new Client interfaces and changes to the Plant 
Applications Administrator. 

• Database purges: Plant Applications supports a Unified Manufacturing Database 
(UMDB) to combine a SOA database employing an S95 data model with a Plant 
Applications database. Purging data from the UMDB is a two-step process involving 
both the Plant Applications and SOA purge utilities. The following notes apply to a 
purge of the Plant Applications database: 

• Perform online purges to Plant Applications databases before upgrading to 
the latest version. 

• For sites using only the Plant Applications data model, there are cursor 
purges that can be executed to trim the database as an interim solution. 

• For sites incorporating both the Plant Applications and S95 data models, do 
not purge the PA database as this will orphan data on the WF side and could 
introduce issues. 

• Conversion of custom containers and displays remains a GE IP Services function. 

• Moving or renaming a server after migrating to a UMDB. 

• Standard Plant Applications 5.0 scripts work with Plant Applications 8.0 to 
move or rename the server. 

• Refer to Workflow documentation for information about scripts and related 
procedures. 

• Recommended installation paths 

• New naming convention for specific Plant Applications tables starting in version 6.1. 

• UMDB tables have a _Base naming convention and are associated with SQL 
Views for improved performance and to enable modifications without 
impacting existing structures. Data is linked in a view to maintain 
compatibility between the S95 and Plant Applications models. 



Table SQL View 

Product_Base dbo.Products 

Prod_Lines_Base dbo.Prod_Lines 

Prod_Units_Base dbo.Prod_Units 

Departments_Base dbo.Departments 

Users_Base dbo.Users 

Variables_Base dbo.Variables 

• Modification of existing spLocals when upgrading to Plant Applications is 
not needed. 

• Table limitations on the Plant Applications side are not enforced in for the 
S95 structures to SOA to enable incorporation of proactive error checking 
for conditions inside workflows. It is recommended to incorporate field size 
limitations in documents where appropriate. For example, limit 
event_num.Events to 25 characters. 

• Reporting 

• Plant Applications has two reporting structures. 

• Plant Applications continues to have Web Reports for information that is 
specific to Plant Applications. 

• The SOA database (S95 data structure) has its own reporting. 



SQL Server Requirements 

To install Plant Applications, the SQL Server Browser service for SQL Server must be running, 
and the TCP/IP protocol must be enabled. 

The SQL User account used for the database when installing Plant Applications requires, at 
minimum, system administrator privileges. 

If you are installing Plant Applications Server and SQL Server on different computers, you must 
manually enable the TCP/IP protocol. It cannot be enabled remotely. 

Setting up the Remote Data Service 

The Remote Data Service (RDS) allows Plant Applications Client components, including the 
Administrator, to access historians without installing the API components on the local server. 

By consolidating the historian connections, the RDS provides a single point of configuration and 

software installation, making it easier to deploy the Plant Applications software. If you do not use the 

RDS, you must install the Historian API Client Tools on the Plant Applications Server and the individual 

Client workstations. 

1. Use the Plant Applications client installation to install the RDS service on the remote 
historian server. 

2. Edit the historian in the Plant Applications Administrator, then select the Remote Data 
Source option to facilitate communications. 

3. Install Historian Client API tools. 

a. Install the Historian on the computer where you will install the Plant Applications server. 

b. Select the following components on the Select Components page: 

• Historian Excel Add-in 

• Historian Administrator 

• Historian Client Tools 

• Historian Documentation & Help 

• OLE DB 

c. Click Next, then click Finish to restart the computer with your changes. 



Upgrade Strategies 

When upgrading Plant Applications 6.3 or 7.0 to 8.0, you must take UMDB management into 
account. 

For more information, on handling your UMDB, see Database Setup Strategies. You should 
always back up an existing database. See Upgrading from Plant Applications Version 6.3 or 7.0 
to 8.0 if you are upgrading from Plant Applications 6.3 or 7.0 to 8.0, or contact Support 
at Support if you are running a version of Plant Applications that does not support the UMDB or 
for any other upgrade paths. 

Database Setup Strategies 

The SOA platform and Plant Applications employ SQL databases running on SQL Server software 
to store information. 

Merging an existing SOA database with an existing Plant Applications database to form a 
Unified Manufacturing Database (UMDB) requires detailed planning. The strategy you employ 
to set up database depends on your existing situation and your goals. For example, you can opt 
for a new installation with a new database, or you can upgrade an existing database to install a 
UMDB. It is probably a rare case that you would need to install a UMDB that combines 
existing SOA and Plant Applications databases. The UMDB can reside on the same machine as 
the Plant Applications server or on a separate server with SQL Server installed. 

You can use one of the following basic strategies for establishing a database: 

Create a New Database for New Data 

Enter a new database name during the Workflow installation with the intention of starting fresh 
with new data for a new UMDB to hold and Plant Applications data. The necessary SQL 
database tables, compatible with the software versions, are set up. 

When using Workflow Client to create equipment, material, and personnel, the entities are 
aspected to the Plant Applications data model for access in Plant Applications. In the same way, 
entities created in Plant Applications are aspected for use in the WorkflowClient. To create a 
new database, enter a new database name. Refer to Plant Applications Client Help for 
information about Fully Qualified Domain Names. 

You should back up an existing database before installing a new release of Workflow or Plant 
Applications. SQL Server changes to the SOA database, such as the addition of data models and 
tables included with software, cannot be reversed. 

https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/general-contact-information#concept_f39c7423-9ff1-46e8-9f90-e6afb1d4a595


Point to an Existing Database  

If you have an existing SOA or Plant Applications database, you can point to the database 
during the Workflow installation and a subsequent Plant Applications installation. To point to 
an existing database, enter its name when prompted for a database name. During 
the Workflow installation, SOA data tables are updated for compatibility with new software. 

When Plant Applications is installed, the MESCore Service Provider adds the necessary Plant 
Applications tables and aspects to the SOA database to install a UMDB. If you are using only an 
existing Plant Applications database, it will not have any SOA data structures. 

If upgrading an existing SOA database to a UMDB, refer to Preparing a SOA Database for UMDB 
Integration. After Plant Applications is installed, you must run the CreateAspect command 
from the command line with options to prepare the database for migration. 

Create a New Database as a Placeholder 

Enter a new database name as a placeholder during the Workflow installation with the 
intention of later pointing to an existing database. Database upgrade can be a slow process or 
you may want to follow a more complex strategy to merge data. Creating a new database 
during installation helps to not interrupt the installation process while providing options for 
handling database setup. 

• Use the utilities available with SQL Server to move a database from one server to 
another. 

• Historian data is stored in separate tables and may be in a separate database. It is useful 
for reporting to have the Historiandatabase point to a Plant Applications database, 
because alarms are then kept in a common “alarms” table. When generating a 
custom report, you can report on alarms from both Historian and Plant Applications. 

Aspecting 

Aspecting cross-references objects residing in the Plant Applications database with objects that 
follow the S95 data structures used by Workflow. 

Set the UseProficyClient site parameter to True, to enable aspecting. You cannot 
rename aspected items. Aspecting of user names uses the fully-qualified domain name (FQDN) 
specified for a Windows account. For more information, see the Plant Applications Help. 

• When using the Workflow client to create equipment, material, and personnel, the 
entities are aspected to the Plant Applications data model for access in Plant 



Applications. In a similar fashion, entities created in Plant Applications are aspected 
for use in the client. 

• Set the UseProficyClient site parameter to True to merge the Plant 
Applications and the SOA equipment models using the Workflow client. For more 
information, see Enabling the Proficy Client UI and Aspecting in the Plant 
Applications Help. 

About TLS Support 

You must install the following software packages to support transport layer security (TLS) 1.2: 

• Microsoft .NET Framework 4.7 

• Microsoft SQL Server Native Client for the SQL Server (the minimum required version is 
11.4.7001.0) 

Consider the following points to enable TLS 1.2 in operating systems: 

• TLS 1.2 is already enabled in Windows 8 (and later versions) and Windows Server 2012 
(and later versions) operating systems. To use TLS 1.2 in these operating systems, you 
must add registry keys to disable TLS 1.0 and 1.1. 

• To enable TLS 1.2 in operating systems prior to Windows 8 or Windows Server 2012, you 
must add keys, and modify existing keys to disable TLS 1.0 and 1.1. 

NOTE: 

 Use the following URL to access the keys: https://docs.microsoft.com/en-us/previous-

versions/windows/it-pro/windows-server-2012-R2-and-

2012/dn786418(v=ws.11)#BKMK_SchannelTR_TLS10. 

About FIPS Support 

Plant Applications supports Federal Information Process Standards (FIPS). If you want to use 
FIPS-compliant algorithms for encryption, hashing, and signing, you must enable FIPS on the 
machine on which you want to install Plant Applications. 

About the SQL Server AlwaysOn Requirements 

The Plant Applications modules support the Microsoft SQL Server AlwaysOn feature that 
provides a high-availability and disaster-recovery solution for SQL servers. The feature acts as 

https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/dn786418(v=ws.11)#BKMK_SchannelTR_TLS10
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/dn786418(v=ws.11)#BKMK_SchannelTR_TLS10
https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-R2-and-2012/dn786418(v=ws.11)#BKMK_SchannelTR_TLS10


an enterprise-level alternative to database mirroring and maximizes the availability of a set of 
user databases for an enterprise. For more information, refer to the 
URL https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-
2012/ms190202(v%3dsql.110). 

About Replicating Logins and Jobs for the SQL Server Nodes 

For the high-availability solutions to work, you must replicate all the user logins (including the 
default logins ComXClient, ProficyConnect, and ProficyDBO) and all SQL Server Agent Jobs of 
the primary replica of the Plant Applications database (SOADB) to all the secondary replicas of 
the SQL Server instance (nodes used in a cluster environment). In addition, you must create 
replicated user logins with security identifiers (SID) that match those of the primary replica of 
the Plant Applications database. For more information, refer to the 
URL https://docs.microsoft.com/en-us/sql/database-engine/availability-
groups/windows/logins-and-jobs-for-availability-group-databases?view=sql-server-2017. 

About the Tested High-Availability Solutions 

The following table describes the high-availability solutions tested for Plant Applications modules. 

High-Availability Solution Cluster Type SQL Server 

Node 1 

SQL Server 

Node 2 

SQL Server Node 

3 

Failover Cluster Instances Single 

Subnet 

Network A Network A Not applicable 

Failover Cluster Instances Multi-

Subnet 

Network A Network B Not applicable 

Availability Groups Single 

Subnet 

Network A Network A Not applicable 

https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/ms190202(v%3dsql.110)
https://docs.microsoft.com/en-us/previous-versions/sql/sql-server-2012/ms190202(v%3dsql.110)
https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/logins-and-jobs-for-availability-group-databases?view=sql-server-2017
https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/logins-and-jobs-for-availability-group-databases?view=sql-server-2017


High-Availability Solution Cluster Type SQL Server 

Node 1 

SQL Server 

Node 2 

SQL Server Node 

3 

Failover Cluster Instances + 

Availability Groups 

Single 

Subnet 

Network A Network A Network A 

Failover Cluster Instances + 

Availability Groups 

Multi-

Subnet 

Network A Network B Network B 

Failover Cluster Instances + 

Availability Groups 

Multi-

Subnet 

Network A Network B Network A 

NOTE: 

 The performance of a high-availability solution in a multi-subnet cluster environment depends on the 

complexity of the network. 

Installation Overview 

Plant Applications software includes compnents for Plant Applications and Workflow. 

The Unified Manufacturing Database (UMDB) requires Workflow, but you only need licensing if you are 

using workflows. The Proficy Application Server installs Workflow 2.6. If you are upgrading from a 

previous version of Plant Applications, see Upgrading from Plant Applications Version 6.3 or 7.0 to 8.0. 

NOTE: 

 By default, all non GE functionality is installed on the C: drive. If you do not want to use the default 

location, you can manually install the non GE functionality to the required location. 

Run the installfrontend.exe program as an administrator to display 
the Installation menu, which includes the following options: 



Menu Selection Description 

View Documentation Accesses documentation. 

Browse the DVD Displays a dialog for browsing files and folders. 

Exit Closes the menu. 

Proficy Application 

Server 

Installs the Proficy Application Server, which 

includes Workflow. Workflow includes SOA components (without a 

Workflow license), which are necessary to support UMDB data structures. 

Plant Applications Server Installs Proficy Plant Applications and the MESCore Service Provider with 

Proficy Server (Plant Applications) services. 

Plant 

Applications Report 

Server 

Installs the server used to view Plant Applications Web Server reports with a 

browser. 

Plant Applications Client Installs the Plant Applications Administrator option for administration and 

the Plant Applications Client option to access Client displays. Also 

installs Plant Applicationshelp and other documentation. 

Plant Applications .NET 

SDK 

Installs the .NET SDK for use with VB.NET applications. It uses a COM 

wrapper with C# or VB.NET applications.Access additional Utilities for Plant 

Applications 



Menu Selection Description 

Plant 

Applications Message 

Bridge 

Enables real time updates on the Universal Client displays. 

Plant 

Applications Universal 

Client 

Installs the Plant Applications Universal Client. 

SQL Native Client 

download 

Installs the Microsoft SQL Server Native Client. 

By default, Proficy Server services are automatically installed on the computer where the Plant 
Applications Server installation runs. To install Proficy Server services on one computer and 
install the UMDB on another, run the Plant Applications Server installation on the computer 
where you want the Proficy Server services installed. During the installation, you can identify 
the SQL Server where you want to install the UMDB. 

NOTE: 

 The Important Product Information document includes steps for setting up the SQL Server. 

Installing the Proficy Application Server 

The Proficy Application Server installs Workflow components as prerequisites for Plant 
Applications. 

Verify that licensing has been installed before installing the Plant Applications Server. 

Workflow is required even if you are planning to use legacy Plant Applications features 
and Plant Applications data models without any merged SOA data models. You need 
a Workflow license to use workflows. 

During the Proficy Application Server installation, you must specify the location for the SQL 
Server that hosts the database, as well as the the name of the database. Stored in an XML file 
the Plant Applications installation uses this information in one of these scenarios: 



• When Workflow adds Plant Applications tables to the SOA database to install a UMDB. 
After installing Plant Applications, you must run scripts to prepare data when a UMDB 
is installed with existing SOA data. 

• When Workflow adds SOA tables and keys to a Plant Applications database (if specified 
as the database during installation) to install a UMDB. Before installing Workflow, you 
must run a script to prepare the Plant Applications database for the UMDB 
installation. 

Refer to the following log files when troubleshooting service provider installation 
failures: configuresite.log and configureproficymocule.log. You can find the 
log files in the Documents and Settings\users\application data 

proficy\logdirectory, or at \programdata\proficy\logs. 

1. Copy software and extract files to the machine where you want to install the Proficy 
Application Server components, then run InstallFrontEnd.exe as an administrator. 

2. From the Installation Menu, select Proficy Application Server from the Prerequisites group. 

3. Select the Proficy Application Server from the options in the Application Server Setup 
Wizard screen. 

4. Select Core as the type of Proficy Application Server, then click Next. 

5. Accept the End User License Agreement (EULA) for Proficy 
Workflow by clicking I Agree. 

6. From the Installation Folders and Architecture screen, select the destination folders for the 
installation location, then select 32-bit architecture. Click Next to continue. 



 

NOTE: 

 Plant Applications does not support 64-bit architecture. 

7. Specify Active Directory Lightweight Directory Services (AD LDS) settings if using AD LDS, or 
use a standalone local directory. Click Next to continue. 



 

NOTE: 
 If AD LDS is not installed, the wizard defines a standalone local directory. 

8. Verify that the SQL Server Browser service is running. At the Database Configuration screen, 
specify SQL Server settings for the installation. The example screen specifies a database 
named SOADB, which is typical when installing a UMDB from a SOAdatabase. If upgrading 
from an existing Plant Applications database, specify its name. Or enter a new name for the 
UMDB. Click Next to continue. 



 

The SQL User account used for the database when installing Plant Applications requires, at 
minimum, system administraor priviliges. To review login permissions and connection 
properties set up in SQL Server: 

a. Select Properties by right-clicking a server name in Object Explorer in SQL Server 
Management Studio. 

b. Review the Security and Permissions pages in the Server Properties window. 

c. Click View connection properties in the Connections pane. 

9. If needed, start the SQL Server Agent (MSSQLSERVER) service. 

10. At the Security screen, enter administrator credentials for Workflow. 



 

11. From the Service Certificates screen, generate new certificates or import existing 
certificates. For more information, see, SSL Security Certificates. Click Next to continue. 

The installation program places a certificate into the trusted root store on the server where 
the Application Server is installed. 

12. At the Web Service screen, enter credentials for the KSPUser account created to connect the 
Proficy web service to the database. 



 

a. Enter the domain name for the website where the Proficy application web server is 
hosted. 

b. Enter a password for the Internal SQL Database User (KSPUser). 

c. Click Next to continue. 

NOTE: 

 You must install the Plant Applications Server before installing web components on a separate 
machine. 

13. If the installation wizard displays a Firewall Detected message, disable your firewalls 
or configure your computer to communicate with the server. Click Next to continue. 

14. From the Installation Confirmation screen, click Install to install Proficy components. Follow 
any additional screen prompts. 

NOTE: 
 The installation program times out after 10 minutes if the Proficy Server service does not start, and a 
message prompts you to manually start the service. Once the service starts, the installation 
automatically continues. 



The installation script performs the following actions: 

• Installs MS Visual C++ redistributables. 

NOTE: 

 In order to install Workflow 2.6, you may be required to uninstall version VC++ 2017 and 
then reinstall it. 

• Installs Proficy Application Server. 

• Sets up the SOA database. 

• Sets up security. 

• Sets up IIS. 

• Sets up SQL. 

15. Upon successful installation, the wizard displays a confirmation message. Click Exit to close 
the installation wizard. 

16. You can verify that the SQL Server installed successfully by checking the SQL server 
setup failed status in the SetupDataPlantAppsTemplateFile.xml file 
under Program Data/Proficy. 

Binding HTTPS 

After IIS is installed and basic setup completed, you may need to bind an SSL certificate to 
HTTPS on the machine where the web server is installed. 

A certificate was installed when the Proficy Application Server was installed and downloaded to the 

machine where the web server resides as part of its installation. For more information, see the Proficy 

Workflow Getting Started Guide. 

1. Start the Internet Information Services (IIS) Manager. 

2. Navigate to and select Default Web Site. Select Bindings. 



 

The Site Bindings dialog box is displayed. 

 

3. Bind the certificate to HTTPS. 

a. Click Add to display the Add Site Binding dialog box. 

If you are re-binding the HTTPS certificate, select https from the Site Bindings dialog 
box, then click Edit. 

b. Select https in the Type field. 



 

c. In the SSL certificate field, enter the fully-qualified domain name of the server that 
received the certificate. 

For the Proficy Application Server, the server is typically the host that the Web Server 
uses to connect to the server. 
If you are re-binding the HTTPS certificate, the port remains 443. Select your SSL 
certificate from the drop-down menu. Click View to verify that you have a private key 
that corresponds to the certificate. 

d. Click OK to add HTTPS binding to the list of bindings in the Site Bindings dialog box. 

4. Close the Site Bindings dialog box. 

5. Close the Internet Information Services (IIS) Manager. 

After installing Plant Applications Administrator, change the Global Configuration/Plant 

Applications Site Parameters/Client/UseHttps value to True. 

Installing the Plant Applications Server 

• Install Proficy Application Server. 

• Bind HTTPS or select a new port. 

• If upgrading from an earlier version of Plant Applications, verify that the MESCore 
Service Provider is uninstalled. 

• Install a hardware key. 

The SOA platform installed with the Workflow installation is a prerequisite for Plant 
Applications 6.1 or later even if you are planning to use legacy Plant Applications features 
and Plant Applications data models without any merged SOA data models. You do not require 
a Workflow license to use Plant Applications 6.1 or later with the UMDB unless you plan to use 
workflows. 



The configuresite.log and configureproficymocule.log files can be useful for 
troubleshooting if a service provider is not correctly installed. These logs are stored 
under users\application data proficy\log in the Documents and 

Settings folder or at \programdata\proficy\logs. 

1. Select Plant Applications Server from the Installation menu to start the Setup Wizard. If the 
installation does not automatically start, locate and double-click 
the ProficyServer.exe file. 

2. Accept the End User License Agreement (EULA), then click I Agree to continue. 

3. Enter the administrator credentials for the Proficy (Workflow) SOA Server or Proficy 
(Workflow) Client at the Configure Security screen, then click Next to continue. 

In the following example, Admin is the Administrator Name that was entered when 
installing Workflow. 

 

4. If needed, select Install Plant Applications Service Provider (PASP) at the Install PASP screen, 
and click Next. 

NOTE: 
 The PASP supports Plant Applications versions 4.4.1 and 5.0 for customers using interface methods 
published with the old version of the service provider. A standalone installation program is available 
if you install the PASP at a later time. The new MESCore Service Provider, which supports the UMDB, 
is installed with Plant Applications 6.0 or higher. Methods for the PASP remain documented in the 



Proficy Workflow help. You must install the PASP to run any workflow applications developed to run 
against Plant Applications 6.0 and earlier, as they will not run with the new MESCore SP. 

5. From the Ready to Install screen, click Install to start the installation. 

The installation script times out after 10 minutes if the Proficy Server service does not start, 
and prompts you to manually start the service. Once the service is started, the installation 
automatically continues. 
The installation script performs the following actions: 

• Maps user accounts to the installed database. 

• Installs Plant Applications Server. 

• Sets COM DLLs and ActiveX controls by registering the following files: 

• C:\Program Files\Common Files\Proficy\Plant 

Applications\PRMsgs.dll 

• C:\Program Files\Common Files\Proficy\Plant 

Applications\ProfSVR.dll 

• Creates the Plant Applications database and tables, and populates the database 
(database size affects length of time). 

• Installs the MESCore Service Provider module. 

• Stops the Proficy Server, Proficy Publisher, and Proficy STS services. 

• Installs product options, including displays, and sets up the Proficy site, Plant 
Applications services, and MESCore service views and triggers. 

• Creates a BAT file with uninstall settings. 

• Calls a data model loader to create aspect tables for the database. 

• Starts the PRLicenseMgr, PRProficyMgr, and Plant Applications 

services, and restarts Proficy services. 

6. From the Configure Site screen, enable any essential product items. 



 

Click Save to save your changes, then click Exit to complete the wizard. 

7. Click Exit to close the wizard. 

8. Confirm that the Proficy Server and Proficy Server Manager services are started. If services 
fail to start, check the applicable log files. 

9. Verify your installation by checking the installation log files. 

Directory Action 

<Drive>:\<Program 

Files>\Proficy\Proficy 

Database\SetupLogs 

Verify 

that Verifies.log and StoredProcedures.log files for 

the UMDB contain no errors. 



Directory Action 

<Drive>:\<Program 

Files>\Proficy\Proficy 

Server\SetupLogs 

Verify that its StoredProcedures.log file contains no errors. 

<Drive>:\<Program 

Files>\Proficy\Proficy 

Server\LogFiles 

Verify that the Plant Applications Service log 

files, CalculationMgr-xx.log files, and Gateway-

xx.log files contain a Connected to Router notification. 

This notification indicates that the TCP/IP communications are 

functioning successfully on the Plant Applications Server. 

<Drive>:\<Program 

Files>\Proficy\Proficy 

Server\LogFiles 

Verify that the Router-xx.log file initialized successfully and 

does not contain any errors. 

Installing the Plant Applications Client and Administrator 

If you are using Web Server reports, install the Plant Applications Report (Web) Server after 
installing the Plant Applications Server, but before installing a Plant Applications Client. 

The Report (Web) Server is required for Web Server reports. Before installing, verify that the 
required IIS roles are installed. When installing IIS, make sure that WebDAV is not installed. 

If an error occurs when loading the ISAPI filters, check the ISAPI file path. 

The client installation installs the Plant Applications Client and Administrator, Plant 
Applications Excel Add-in, Downtime Supervisor Screens, and Help files. It also installs 
Development tools and remote services, including the Plant Applications OPC Server and 
Remote Data Services. Plant Applications Administrator is the primary means of maintaining 
and managing the Plant Applications software. You can control system security by limiting the 
number of computers with the Administrator program installed. 

To make it easier for technical support to quickly correct any potential problems, install 
the Plant Applications Administrator and Client software on the same computer as the Plant 



Applications Server. Also, install the Administrator and Client software on workstations that 
maintain the Plant Applications configuration. 

1. Select Plant Applications Client from the Installation Menu, then click Next at 
the Welcome screen. 

2. When prompted, click OK to review the Important Product Information page. 

3. From the Custom Setup screen, select Plant Applications Client and Plant Applications Excel 
Add-in from the list of options. 

You can also select Plant Applications Administrator, OPC Server, and Remote Data 
Services to install. 
No prerequisite software is required to install the Proficy OPC Server. However, you can use 
an OPC test client such as Matrikon OPC Explorer to test connections to the OPC Server. 
See Plant Applications Help to set up a user account. 
Click Space to display the available and required space for features. 

4. Click Next to continue. 

You are prompted to install desktop shortcuts and, if needed, Microsoft Excel. 

5. Enter the name of the SQL database server, or click Browse button to select one. 
Click Next to continue. 

6. On the next screen, accept or change the destination folder. 

7. Click Yes to allow Plant Applications to bypass firewall and port settings, or to make 
appropriate setup changes. 

8. From the Ready to Install screen, click Install. 

The Installing Plant Applications Client screen is displayed as the wizard installs the software 
and completes post-installation tasks. 

9. When the wizard displays the InstallShield Wizard Completed screen, click Finish. Ignore an 
error message related to a file unzip action not responding. 

Start the Plant Applications Administrator and Client. See Maintenance and Troubleshooting topics in 

the event of any server connection failures. 

Data Authorization for Events Configured for Each Event Type 

Follow these rules to set up authorization access for event properties: 



• If the time stamp of the event for which you want to edit property data is before 
the MaxEdit window and the user does not have Read/Write access to the 
Administrator group, lock the cell for editing. 

• A security group can be assigned directly to a variable, sheet or sheet group. If there is 
no security group assigned to the sheet, it inherits the security group assigned to the 
sheet group. When determining the access level, use the lowest access level between 
the variable and sheet. 

• Determine the AccessLevel for a specific Property. If 
the PropertyAccessLevel is less than the SheetAccessLeveland a security 
group is assigned to the variable, use the PropertyAccessLevel. Otherwise, use 

the SheetAccessLevel. If the PropertyAccessLevel is greater than 

the SheetAccessLevel and a security group is assigned to the sheet or sheet 
group, use the SheetAccessLevel. Otherwise, use 
the PropertyAccessLevel. 

• Determine the write access. If the AccessLevel is the same as the level for the 

Administrator of the security group or the user has Read/Write access to the 
Administrator group, set the WriteAccess as True regardless of data source. If 
the AccessLevel is less than the level for the Administrator and the DataSource is 
2 (Autolog), set the WriteAccess to True, but only if the AccessLevel is 
greater than or equal to the Read/Write level. 

Installing the Plant Applications SDK 

The Plant Applications SDK is a DLL that exposes methods to read and write Plant 
Applications data to use with VB.NET applications, Excel reports, and so forth. 

A functional change has been introduced for Plant Applications SDK to address the incorrect 
message issue. In the event a message is sent to the database manager with Write Direct = 
False and Pending = False, a “pre” message was issued. Now, with the introduction of the 
messaging bridge a “post” message is issued, which is the proper implementation. 

Existing functionality where Write Direct = True is unchanged. 

Plant Applications 6.1 added a COM wrapper to the .NET SDK to use with C# or VB.NET 
applications. Refer to the Plant Applications Help for coding examples. When upgrading from 
the .COM SDK, SDK applications must be completely rewritten to use the .NET SDK. For more 
information, see the knowledgebase at the Support site. 



NOTE: 

 The COM wrapper does not support BigInt (long integers) in the Tests table because Visual Basic and 

COM do not support 64 bits. 

1. Select Plant Applications .NET SDK from the Installation Menu. 

2. Click Next at the Welcome screen. 

3. From the Setup Type screen, select Typical to install DLLs or Custom to provide options to 
install help or the SDK test application. 

4. Click Next. If you selected the Custom installation options, make the applicable 

selections. 

5. Click Finish. 

Installing the Plant Applications Message Bridge 

You must install the Plant Applications Message Bridge on the Plant Applications server node to 
access the real-time updates on the applications in the Plant Applications Universal Client. 

We recommend that the Plant Applications Message Bridge be installed before installing the Plant 

Applications Universal Client. In addition, the Message Bridge configuration file will not be replaced with 

the new one during the installation. Therefore, we recommend that you delete the existing 

configuration file located at <Plant Applications installation folder>\Proficy 
Server\RabbitMQMessageBridgeService\Proficy.PlantApps.MessageBridge.Se

rvice.exe. 

• Ensure that you complete the following procedure specific to the Plant 
Applications Message Bridge: 

1. Uninstall the earlier version of the Plant Applications Message Bridge. 

The Proficy Server Message Bridge service is disabled. 

2. Delete the directory - C:\Program Files (x86)\Proficy\Proficy 
Server\RabbitMQMessageBridgeService. 

3. Restart your computer. 

4. Install the version of the Plant Applications Message Bridge included in the Plant 
Applications installer. 

5. Restart the Proficy Server Manager service. 



The Proficy Server Message Bridge service is automatically restarted. 

• Ensure that you create a backup copy of the text file that includes the user-specific 
settings. The file is created in the directory <tomcat_home>/Apache Software 
Foundation/Tomcat 9.0/users/<user>, where: 

• <tomcat_home> is the directory where you installed Apache Tomcat. For 
example, C:/Program Files. 

• <user> is the name of a logged-in user. 

After you upgrade, you can copy-paste the file to the same location to replicate the 
user-specific settings. For more information, refer to the Plant Applications Universal 
Client Help. 

The Plant Applications Message Bridge installer installs the following prerequisites: 

• Erlang OTP 

• RabbitMQ Server 

NOTE: 

 If the Plant Applications Message Bridge is currently installed, do not reinstall the Message Bridge. You 

can verify whether the Message Bridge is installed in the Programs and Features list on your computer 

as shown in the following image. 

 

1. Select the Plant Applications Message Bridge wizard, and, on the welcome screen, 
select Next to install the Message Bridge. 



 

The Missing Prerequisites screen appears, listing any prerequisites that must be installed. 



 

2. In the Missing Prerequisites screen, select Continue to install any missing prerequisites. 

The Read and accept the license agreement to continue screen appears. 

3. Read the license agreement, select Accept, and then select Next to continue the installation. 

The Microsoft SQL Server Credentials screen appears. 



 

4. In the Microsoft SQL Server Credentials screen, enter the credentials to access the Microsoft 
SQL server as described in the following table. 

Credential Description 

Hostname Enter the host name where the Microsoft SQL server is installed in the 

format HOST_NAME\INSTANCE, where HOST_NAME is the host name (either a fully 

qualified domain name or IP address, of the server), and INSTANCE is the instance of 

the server. 

Database Enter the name of the Plant Applications database that you want to connect with 

the Plant Applications Universal Client. 



Credential Description 

User Enter the user name that has permissions to access the database you entered in 

the Database box. By default, the user name appears as sa. 

Password Enter the password for the user you entered in the Userbox. 

Instance Enter the name of the instance of the SQL server. Entering an instance is optional. 

Port Enter the number of the port that the instance uses to listen for client connections. 

5. Select Validate Connection to validate the database connection. 

If the database connection is successfully validated, the Next button is enabled. 

6. Select Next. 



The RabbitMQ Administrator Account Credentials screen appears.

 

7. In the RabbitMQ Administrator Account Credentials section, enter the user name and 
password for an existing RabbitMQ Administrator, if RabbitMQ is already installed. Else, 
provide the user name and password you intend to use as an administrator. 

8. In the Plant Applications Administrator Account Credentials section, enter the user name 
and password for an administrator account in Plant Applications, and then select Validate 
Connection to validate the credentials. 

If the credentials are successfully validated, the Next button is enabled. 

9. Select Next. 

The You are ready to install screen appears. 



 

10. Select Install to install all the prerequisites and the Message Bridge. 

Depending on the options selected, the installation process may take some time. The 
installer displays the status updates. 

On successful installation, the Installation Successful screen appears. 



 

11. Optional: Select View Logs to see the installation details. 

12. In the Installation Successful screen, select Exit to close the wizard. 

The Message Bridge is successfully installed on your computer. 

After you install the Message Bridge, complete the following procedure to enable the Proficy Server 

Manager service to pass messages between the Plant Applications: 

1. Configure your Administrator user in RabbitMQ. For more information, refer to 
the Configuring a User in RabbitMQ topic. 

2. Restart the Proficy Server Manager service to automatically start the Proficy Server Message 
Bridge service. 

The Proficy Server Message Bridge service allows messages to pass between the Plant 
Applications clients. 

 



Configuring a User in RabbitMQ 

1. Open the RabbitMQ management console, http://localhost:15672. 

2. Login as a guest. Enter guest as the Username and Password. 

NOTE: 

 The default user “guest” is an administrative user and its login credentials are published on the 
official RabbitMQ web site. It is recommended that you update this user or delete it as per your local 
security policies. 

 

3. On the Admin tab, select Add a User. Enter the username and password provided for the 
RabbitMQ account during the setup and for Tags, select Set > Administrator. 

4. Click Add user. 



 

5. In the All users list, click on the user you just added under the Name column. 

6. Set the required permissions for the user and click Set permission. 

 

7. The page refreshes and the user is added with the selected permissions. 



Installing the Plant Applications Universal Client 

You must install the Plant Applications Universal Client to access the applications within 
the Plant Applications Universal Client. For more information about installing Plant Applications 
Universal Client, refer to the Universal Client Installation Guide. 

Task Lists for ActiveX and SOA Web Client 

ActiveX Task List installation is available as a separate option in a Workflow installation. 

The Web Task List associated with the SOA Web Client is installed as part of the Workflow. 
After Workflow installation, refer to the Workflow Help for the link to connect to the Web Task 
List. 

Preparing a SOA Database for UMDB Integration 

If you are upgrading an existing SOA database to a UMDB, prepare the database for migration 
by running the CreateAspect command from the command line with any required aspect 
options. 

Ensure that Plant Applications is installed. 

The script prepares the SOA data structures to work in the unified data model of the UMDB. For 
more information, see Database Setup Strategies. 

NOTE: 

 Setting the UseProficyClient site parameter to True enables aspecting and disables the renaming 

of aspected items. Aspected user names require a fully-qualified domain name (FQDN) as specified for a 

Windows account. See the Plant Applications help for more information. 

1. From a command prompt, enter the Plant Applications installation path. For example: . 

C:\<Program Files location>\Proficy\Proficy Workflow\Program 

2. Run the Proficy.MESCore.Utils.CreateAspect.exe program to create 
Equipment and Material aspects, or add the following options to create aspects: 



Option Description 

/addEquipProp Creates the Equipment Property aspect. 

/addEquipProp 

/addMatProp 
Creates Equipment and Material aspects as well as the Equipment 

Property and Material Property aspects. 

/addEquipProp 

/addMatProp 
Creates Equipment and Material aspects as well as the Equipment 

Property and Material Property aspects. 

3. For example: Proficy.MESCore.Utils.CreateAspect.exe /addEquipProp 
/addMatProp 

Report Server Installation Overview 

Plant Applications offers Web Reports for access through a browser and specialized Web Parts 
for access through a portal using the Report (Web) Server. 

The Plant Applications Report Server must be installed after the Plant Applications Server, but 
before installing a Plant ApplicationsClient. For information about setting up and using Web 
Reports and Web Parts, see the Plant Applications help. 

Web Client Reports offer another means to access similar data. See Plant Applications Client 
Interfaces for information about accessing the Plant Applications Web Server Administrator and 
the Web Server. 

You must also determine the account that the Plant Applications services uses to start. The 
account must have Log on as a service rights. 

For information about installing and using SSRS, see the Proficy Plant Applications SSRS Report 
Configuration and Report Creation Guide, which is posted with KB16011. 

NOTE: 

 The Plant Applications services do not start when using the Local System account. 



Windows Installation Limitations 

By default, Windows Server OS versions do not install the Web Server (IIS), FTP, and ASP 
components required for Web Reports. Before you install the Proficy Application Server, you 
must install the necessary components by following the steps in Setting up IIS Web Services. 

IIS Metabase Configuration Backup 

Metabase backup files contain copies of the metabase configuration file. You can create a 
portable backup if needed. 

You can locate the appropriate information at the correpsonding Microsoft websites: 

• IIS 
6.0: http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/II
S/131b609d-ff3a-488f-a8dd-13044fa623a1.mspx?mfr=true 

• IIS 7.0 and 7.5: http://support.microsoft.com/kb/954872 

Setting Up Internet Explorer Security for Web Reports 

Install web reports. 

1. From Internet Explorer, select Tools > Internet Options. 

2. Select Local Intranet on the Security tab, then click Custom Level to display the Security 
Settings dialog. 

3. Scroll down to User Authentication, then select Automatic logon with current username 
and password. Click OK. 

4. Select Trusted sites on the Security tab, then click Custom Level to display the Security 
Settings dialog. 

5. Scroll down to User Authentication, then select Automatic logon with current username 
and password. Click OK 

6. Select Trusted sites on the Security tab, then click Sites to modify the Trusted sites dialog. 

a. Verify that the web server name and localhost are included in the list of trusted sites in 
the format http://servername. 

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/131b609d-ff3a-488f-a8dd-13044fa623a1.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/131b609d-ff3a-488f-a8dd-13044fa623a1.mspx?mfr=true
http://support.microsoft.com/kb/954872


b. tTo add the web server or local host to the list of trusted sites, enter the server in the Add 
this website to the zone field in the format http://servername, then click Add. 

c. Click Close. 

7. On the Privacy tab, click Advanced to display the Advanced Privacy Settings dialog. 

8. Select Override automatic cookie handling, then click OK. 

9. Scroll down to Security on the Advanced tab, and verify that Enable Integrated Windows 
Authentication (requires restart) is selected. Click OK. 

Installing the Plant Applications Report Server 

After installing IIS roles, you can install the Plant Applications Report Server. 

Determine which components to install and complete the required prerequisites. 

• Verify that role services have been installed as described in the Setting up IIS Web 
Services section in the Plant ApplicationsGetting Started Guide in  Setting up IIS Web 
Services. 

• If planning to use a web portal (for example, Proficy Portal or SharePoint Services), 
verify the portal has been installed before installing the Web Server. 

• A PDF distiller is installed to generate reports in PDF format. A default printer must be 
installed on the computer, and the PDF service must start with its own Windows user 
account (Login As Service policy required) for the report engines to print or produce 
reports in PDF format. For more information, see Adding a Printer in the Web Server 
and Web Client section of the Plant Applications Help. 

• Microsoft Excel is required to install Plant Applications Web engines. 

NOTE: 

 After installing the Plant Applications Web Server, you must start Excel under the same login 
account used by the Plant Applications Report engine services. 

NOTE: 

 By default, SharePoint Portal Services 3.0 uses port 80, also used by Plant Applications Web Server. You 

must change SharePoint to use an open port, such as port 81. 

Web Reports can use the following components: 

• Plant Applications Server – Interacts with the Web Server and maintains a profile of 
Web Client users. 



• Plant Applications Web Server – Framework to schedule and distribute standard and ad-
hoc web reports by means of the Plant Applications Web Client. 

• Plant Applications Web Parts – Customizable web components for use in a portal to 
view relevant plant information in real time. 

• Plant Applications Web Content and Web Report Engines – Generate content data for 
Web Parts and reports. When report generation time increases or CPU usage is high, 
you should place another engine into service. 

NOTE: 

• If you are installing Plant Applications in a production environment, you must 
install the Plant Applications Web Server, engines, and Plant Applications Server on 
different computers. You can install all components on a single computer for 
testing. 

• Engine services do not start unless assigned their own Windows user 
account. Login As Service policy required. 

1. Run InstallFrontEnd.exe to display the Plant Applications Installation Menu. 

2. Select Plant Applications Report Server to start the installation program. If the installation 
does not start, run the PlantApplicationsWebServer.exe file. 

3. Click Next at the Welcome screen, click OK at the next screen to proceed, and then 
click Yes to override firewall settings. 

4. At the Custom Setup screen, select the components to install on this server. Click Next to 
continue. 



 

5. If a dialog opens to to acknowledge installation of a distiller to produce PDF documents, 
click OK 

6. Accept default port numbers for the HTTPS port, or enter different ports as needed. 
Click Next. 



 

7. Enter the name of the SQL Database server if prompted, and select the authentication 
method. If using Server authentication, enter the server credentials, then click Next. 



 

The Web Server installation program checks a specific registry key for an existing SQL Server 
name. 

8. Click Next to continue. Record any listed tasks that you may need to complete. 

9. Click Next to continue, and complete the dialog when prompted: 

a. Confirm whether you want to install the Plant Applications Web Reporting engines on the 
same computer as the Plant Applications Server. 

b. If the Plant Applications Web Server already exists, confirm that you want to overwrite its 
configuration. 

c. Click Next. 

10. Enter the Windows Account (username) and Password of the local Windows user account for 
the machine where the Plant Applications Report engines and Plant Applications services will 
be running. Click Next. 

NOTE: 

 Although the Plant Applications services run under the Local System account, you should use a local 
Windows user account. 



11. At the Destination Folder screen, accept the default location for the web server destination 
folder, or click Browse to select another location. Click Next. 

12. Click OK to acknowledge that SharePoint Portal Services are required to access Sharepoint 
dashboards. 

NOTE: 

 See Changing the SharePoint Port Number for steps to use a port other than port 80. 

13. Click Install at the Ready to Install the Program screen to begin copying files. 

The installation program sets up the web server. The program installs the Microsoft SOAP if 
needed, imports the Web Part templates, and populates the database. 

NOTE: 

 If a portal is not found, a prompt notifies you that Web parts will be available only through the Plant 
Applications Web Server or Proficy Real-time Information Portal (RTIP). 

14. Click Finish. 

Report Server instances are displayed under the Sites folder in the IIS Manager. 

15. Restart your computer to complete the installation. 

1. Log into the computer with the newly installed Report Server using the Windows User 
Account that was selected during the installation. 

2. Verify that the DashboardImport.log and ExecuteScripts installation log files 
contain no errors. By default, the log files are located in C:\Program Files 
(x86)\Proficy\Plant Applications Web Server\SetupLogs. 

3. Access the Site Parameters sheet by selecting Administer Site Parameters 

under Global Settings in the Plant Applications Administrator, and set UseHttps in 
the Client section to True. 

These additional steps may be required to complete installing the Report Server: 

• Follow the steps in Configuring the Plant Applications Report (Web) Server to set up a 
different user only if the Report Server is installed on a non-local machine. 

• Follow the steps in Secure Socket Layer and Certificate Requirements  available in Plant 
Applications Getting Started Guide to support the functionality of secure (HTTPS) 
URLs. 

• Configure Excel as described in Setting Up the Plant Applications Excel Add-In available 
in Plant Applications Getting Started Guide. 



After installing the Plant Applications Report (Web) Server, return to Installing the Plant 
Applications Client and Administrator. 

Setting Up the Plant Applications Report Server 

• Install the Plant Applications Report (Web) Server. 

• In the Services screen, verify that the Plant Applications Report Engine services are 
logging in under the domain user you specified when installing the Report Server. 
Check the Log On As column for each service. 

• If the Proficy Server Remote Data Service resides on the Plant Applications server, verify 
that the service logs in under the domain user. If the Proficy Server Remote Data 
Service resides on another server, such as the Plant Applications Web server, use a 
Windows user account or a local administrator account with Log on as a Service rights 
instead of Local System. 

• Verify that the domain user has Log on as a Service rights. 

1. Start Excel under the same login account used by the Plant Applications Report Engine 
services. 

2. Under the Internet Information Services (IIS) Manager, verify that Anonymous access has 
been enabled for the three virtual FTP directories (Templates, Reports, and 

PAReporting) by enabling Anonymous Authentication for the PAReportingFTP site. 

 

NOTE: 

 By default, this action occurs when installing the Web Server for Plant Applications. 

3. Verify that the anonymous users (IUSR_*) have full control. 

4. Verify that you can use FTP, and log in as anonymous. 

5. Right-click the ..\inetpub\wwwroot folder in Windows Explorer, select Properties, and 

then open the Security tab. Grant full control under Permissions to all users 



including Users <computer name>, IIS_IUSR_<computer name> (Internet Guest 
Account) and IIS_WPG (Launch IIS Process Account). 

6. In Local Users and Groups (access from Computer Management, or search for “Local Users” 
from the Windows Start menu), add the following users to the Administrators group: 

• IUSR_<computer name> (Internet Guest Account) 

• IWAM_<computer name> (Launch IIS Process Account) 

Secure Socket Layer and Certificate Requirements 

The Plant Applications Report Server requires a valid IIS server certificate to work in SSL mode. 

When you install and access the Report Server across different machines, the certificate should 
be validated across machines and preferably signed by a Certificate Authority (CA) known to 
these machines. 

Setting Up IIS for Remote Use 

When the Plant Applications Report Server has been installed on a different machine from 
the Plant Applications Web Client, you must configure Plant Applications Report Server 
applications (PAReporting, Apps, and ProficyDashBoard) to use different X-Frame-Options. 

1. Start the Internet Information Services (IIS) Manager. 

2. In the IIS Manger, drill down in the Connections tree to Sites > Default Web Site > Apps, and 
then select HTTP Response Headers. 



 

Setting Up the Plant Applications Excel Add-In 

1. Start Excel from the command line. 

a. Click Start > Run. 

b. Type excel.exe in the Open field, then click OK. 

2. Click Microsoft Office, then click Excel Options. 

3. Click the Add-Ins category 

4. In the Manage box, click Excel Add-ins, then click Go to display the Add-Ins dialog box. 

5. Select the Plant Applications Excel Add-In check box, then click OK. 

A message verifies the Plant Applications Add-in has been installed. 

6. Click Plant Applications on the Add-ins ribbon, then click Options to display the Plant 
Applications Add In Options dialog box. 

7. Under Server Access, verify the following three items in the display 



• Correct default server. 

• Correct user. 

• Connected status. 

If not: 

d. Click Edit to display the Connect Server dialog to edit the user details. If necessary, log in 
with Plant ApplicationsAdministrator credentials. 

e. Right-click the server, then click Edit to update the Add-in connection details. 

f. In the Server dialog, click Advanced, and verify that the Default Server is selected. 
Click OK. 

g. If the Add-In is not connected to the server, right-click the server. Select Connect, then 
click Close. 

h. Click Save to update the registry settings. 

8. Click the Microsoft Office button, then select Excel Options to display the Excel 
Options screen. 

9. Click Trust Center, then click Trust Center Settings to display the Trust Center screen. 

10. Click Add-ins, and verify that all options are not selected. 

11. Click Macro Settings, then select Enable all macros. 

12. Click OK, then click Save. 

13. Clear the Save AutoRecover information every option, then select the Disable AutoRecover 
for this workbook onlyoption. 

14. Click OK and close Excel. 

Verify the virtual directories have been created: 

1. Open Administrative Tools from the Control Panel, then select Internet Services 
Manager or Internet Information Services (IIS) Manager. 

2. Expand the IIS tree, then open the Web Sites folder. 

3. Expand Default Web Site to display the virtual directories. Verify that the following three 
virtual directories have been created in IIS: 



• Apps 

• Reports 

• PAReporting 

For information about installing and using SSRS, refer to the Proficy Plant Applications SSRS 
Report Configuration and Report Creation Guide, which is posted with KB16011. 

If you installed the Plant Applications Web Parts, also verify that the virtual 
directories ProficyWebParts and ProficyDashboard have been created. 

Local Client Application Support 

You can install local copies of the Plant Applications Administrator, Plant Applications Client, 
and Workflow Client and directed them to an installed server to access the Unified 
Manufacturing Database (UMDB), a historian, and Web Server reports. 

Use the Proficy Applications Client selection from the Plant Applications Installation Menu. 

UTC Support 

Plant Applications supports Coordinated Universal Time (UTC) as an option on a fresh 
installation of the Proficy Server.  

When you install a new Proficy Server, you can use the time zone of the server to store your 
data or you can use the UTC option. The UTC option is required to support a Regional Server 
where plants span time zones. It is also required to support storage of time across the Daylight 
Saving Time (DST) boundary. UTC is similar to using GMT +0:00 as your time zone, with the 
exception that UTC does not acknowledge Daylight Saving Time. For example, GMT -6:00 is 
minus five hours from UTC, when adjusting for Daylight Saving Time. When you choose the UTC 
option, all the data is stored on your server in UTC time regardless of the time zone of the 
server.  

Visit this Knowledge Base article to understand how to implement Coordinated Universal Time. 
https://digitalsupport.ge.com/communities/en_US/Article/To-Leverage-The-UTC-Functions-in-
The-Latest-50-Release.  

https://digitalsupport.ge.com/communities/en_US/Article/To-Leverage-The-UTC-Functions-in-The-Latest-50-Release
https://digitalsupport.ge.com/communities/en_US/Article/To-Leverage-The-UTC-Functions-in-The-Latest-50-Release


Reporting and UTC 

Plant Applications displays support UTC including displaying data across the DTS boundary. 
When data comes into a display, the timestamp is converted to the time zone of the client. For 
example, a test value with a UTC timestamp of 07:00:00 would be displayed with a timestamp 
of 02:00:00 on a client with a time zone of GMT -6:00 (assuming Daylight Saving Time). For data 
that crosses the Fall DST boundary, you see multiple rows and columns arranged in UTC order, 
depending on the display, in the same time range. For example, you can set up a time-based 
Autolog display which includes columns of 30-minute samples. Assuming your DST boundary is 
at 2:00 AM, the first 1:30 AM column in Autolog precedes 2:00 AM, while the second 1:30 AM 
column presents its sample after the DST boundary. 

Plant Applications 6.1 or higher supports UTC-enabled standard reports and a UTC-enabled 
Excel Add-in. 

NOTE: 

 To use custom reports with UTC, you must rewrite the reports. 

Default Time Zone Site Parameter 

Use the Default Time Zone site parameter to specify UTC or the time zone of the server. You 
cannot edit this option after entering data in the Plant Applications database. This option is not 
available when upgrading directly from an earlier version of Plant Applications. 

Upgrading Plant Applications to Use UTC 

You must manually upgrade your system to use UTC on an existing Plant 
Applications installation. 

Make a copy of your production database. You can use the production database copy as a backup or for 

reporting. 

NOTE: 

 These options require advanced knowledge of both SQL Server and Plant Applications. You should test 

the results of either action before implementing them in a production environment. 

• Create a gap in your data, based on your server time. 

1. Change the UTC. 



Server 

time 

Do this Example 

GMT Switch to UTC. The gap is created 

automatically when you switch to 

UTC time. 

If you are at GMT -5:00 and your last data was 

recorded at 14:22, when you switch to UTC 

(GMT) the data is stored at 19:22, creating a gap 

in your data of five hours. 

+GMT Wait until the UTC time is newer 

than the last time stamp in the 

database. This prevents data from 

being overwritten. 

If you are at GMT +3:00 and your last data was 

recorded at 11:00:00, you can shut down the 

server, wait for four hours and switch to UTC. 

The system stores your data i at 12:00:00, 

providing a one-hour gap. 

2. Move the server as described in the Knowledgebase article KB5427 at the Support 
web site: https://digitalsupport.ge.com. 

• To eliminate the runtime data from the copy of your database, move the server as 
specified in KB5427 and truncate your runtime data. See the the support web 
site https://digitalsupport.ge.com for the additional truncation procedure. 

Setting Up Languages for Plant Applications Displays 

After installing Plant Applications, you can implement support for additional languages using its 
Native Language Support (NLS) features. 

1. Select All Programs from the Windows Start menu. 

2. In the Proficy folder, open the Proficy Plant Applications folder. 

3. In the Configuration folder, select Configure Plant Applications 

Language Support. You can also run ConfigurePALanguages.exe to set up 
language support. 

4. At the Configure Plant Applications Database screen, modify any server settings as needed. 

5. Select one or more languages to include, then click Save. 

https://digitalsupport.ge.com/
https://digitalsupport.ge.com/


TIP: 

 Use these options to set up language support after any subsequent Service pack or SIM upgrade. 

Managing Port 12280 Conflicts 

Communication conflicts can arise when some third-party applications use port 12280, also 
used by Plant Applications, which can cause the application to disconnect from the router. 

If necessary, update the default communications port inside Plant Applications INI files. See Proficy 

Router Conflicts to modify the default port values. 

Security Modification for Proficy Plant Server 

See Security Management in the Plant Applications Help for additional details on setting up 
your security. 

Database Purges 

Plant Applications provides a Unified Manufacturing Database (UMDB) that combines 
a Workflow (SOA) database with a Plant Applications database. 

Purging data reduces the amount of used space in the database. It does not reduce the size of 
the database. For instructions to reduce the size of the database, consult SQL Server 
documentation. 

Purging the database is a two-step process involving the Plant Applications and SOA purge 
utilities. Contact Support at https://digitalsupport.ge.com/ for more information. 

The following notes apply to a purge of the Plant Applications database: 

• Perform online purges to Plant Applications databases before upgrading. 

• For sites using only the Plant Applications data model, you can perform cursor purges to 
trim the database as an interim solution. 

• For sites incorporating both the Plant Applications and S95 data models, do not purge 
the Plant Applications database. Doing so orphans data in the SOA environment, and 
can introduce other issues. 

You can use the Plant Applications Purge Utilities to conduct database purges online or offline. 
When creating an online purge plan, you should perform an initial database purge based on 

https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/proficy-router-conflicts#task_8b7cce79-918a-4f99-bf18-c0eda1f0bb47
https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/proficy-router-conflicts#task_8b7cce79-918a-4f99-bf18-c0eda1f0bb47
https://digitalsupport.ge.com/


your site’s desired retention limit. For more information, see KB14802 
on https://digitalsupport.ge.com/. 

Customizing Your Application 

You can edit the values in the Plant Applications configuration file to customize your 
installation. 

Change any of the following parameters in the configuration file as needed. 

<filename> Parameters 

Parameter Description 

EventNumIsNumber For the Excel Add-in to translate numeric values, set this value 

to True. The default value is False. See 

the EventNumIsNumber site parameter in the Plant 

Applications Help. 

ProdCodeIsNumber For the Excel Add-in to translate numeric values, change this value 

to True. (The default value is False.) See 

the ProdCodeIsNumber site parameter in Plant ApplicationsHelp. 

AllowPasswordSave To prevent users from saving their client passwords to local 

workstations, change this value to False. The default value is True. 

See AllowPasswordSave in the Plant ApplicationsHelp. 

LanguageNumber By default, the site language is set to U.S. English. To change the default 

language, edit this value. See the LanguageNumber parameter in 

the Plant Applications Help. 

https://digitalsupport.ge.com/


<filename> Parameters 

Parameter Description 

StartupSetBack By default, the Event Manager service looks back three days (4320 

minutes) to look for events at startup. To change this interval, edit 

the EventMgr system value. The suggested configuration is 6 to 12 

hours. Services must be restarted for changes to take effect. See 

the System Users in Plant Applications Help. 

SpecificationSetting The Autolog display uses this parameter to color-code test values by 

comparing them to the specification limits defined for each variables. 

When the value is 1 (the default) and the Test Values limit is greater 

than the Triggering Specification Limit, it triggers a specification flag 

updating the Test Values Color. When the value is 0 and the Test Values 

limit is greater than or equal to the Triggering Specification Limit, it 

triggers a specification flag updating the Test Values Color. 

UseProficyClient Set this site parameter to True to merge the Plant 

Applications and SOA equipment models using the Workflow) Client. 

Refer to Enabling the Proficy Client UI and Aspecting in the Plant 

Applications Help. 

MinEventTimeSpan To reduce the frequency of event generation, set this value to 0. The 

default value of this parameter is four minutes. For more information, 

see the MinEventTimeSpan site parameter in the Plant 

Applications Help. 

Plant Applications Administrator 

The Plant Applications Administrator is the main client application for administrators 
configuring the system. 



Use the Plant Applications Administrator to perform the following tasks: 

• Configure data captured from the plant floor and other sources. 

• Create security rights for data input, changes, verification, and viewing. 

• Process collected information using calculations and many other data functions. 

• Provide the link and the structure to the SQL database where the data is stored. 

• Design displays viewed through the Plant Applications Client application. 

• Provide a method for importing and exporting Plant Applications data. 

The Plant Applications Administrator environment is similar to Windows Explorer. On the left 
side of the main screen is thePlant Applications Administrator tree. From this hierarchical tree 
all tasks can be performed. For the most part, every object in the Administrator tree can be 
right-clicked to view a menu of the available commands. The center pane displays additional 
details about objects directly below the currently selected level. The right pane displays the 
hyperlink menu, if you have that option enabled. 

 

Legend: 

1. Right-click objects in the Plant Applications Administrator tree to view a menu of available 
commands. 

2. The Plant Applications toolbar provides a shortcut to the various levels in the Administrator 
tree. 



3. The Detail pane displays the contents of the object selected in the Administrator tree. 

4. If the Hyperlink button is active, all tasks that can be performed on the object selected in the 
Administrator tree are presented as hyperlinks. 

Plant Applications Client 

The Plant Applications Client provides a customizable environment for using Plant 
Applications Views and Displays to access your plant data. For more information about using 
the Plant Applications Client, refer to Plant Applications Help. 

 

Legend: 

1. A View is a group of displays that can be opened at the same time. Views are created in 
the Plant Applications Client. 

2. The toolbar provides a quick way to perform tasks specific to the active display. The toolbar 
automatically changes depending on which display is active. 

3. The box indicates the status of the connection to the Plant Applications Server. Green 
indicates the connection is active. 



4. This area displays the name of the person who is currently logged in to the Plant 
Applications Client. 

5. Click the tabs to switch between displays. 

Workflow Client 

Use the Proficy (Workflow) Client interface to define resources and execute workflows when 
working with a UMDB. 

For more information about using the Proficy (Workflow) Client, see the Workflow Help. For 
more information about newPlant Applications features accessed through the Proficy 
(Workflow) Client refer to the Plant Applications Help. 

NOTE: 

 Set the UseProficyClient Site Parameter to True to merge the Plant Applications model 

with the SOA Equipment Model when preparing to use the Workflow Client. 

 

Legend: 

1. Use the Navigator to change the focus between objects in a model. 



2. Use solution panels to view collections of editors, views, and reports specific to each model 
resource. 

3. Use displays (Views) to show options after a resource object is selected. 

4. Use the Workspace to view details of a selected object, and to present editors used to 
configure and modify model resources. 

 

 

 

Plant Applications Report Server Administrator 

Use the Web Server Administrator, accessed through the Plant Applications Administrator, to 
set up the Plant Applications Report (Web) Server. The Web Administrator can be started from 
any computer with Plant Applications Administrator installed. 

To start the Web Server Administrator, expand Server Management in the Plant 
Applications Administrator tree and double-click Administrator Web Server. 

 



Legend: 

1. Use the toolbar to change the view of the contents in the right pane, start the Automated 
Certificate of Analysis (COA) applications, and schedule a report. 

2. From the File menu, you can import Web report packages and exit the application. From 
the View menu, you can refresh the view. From the Help menu, you can access the online 
help file and view information about your version of the Web Administrator. 

3. The left pane displays the Web Administrator tree for you to add users, schedule reports, 
manage the Web Server, and manage Web reports. 

4. The right pane displays the contents of the node that you have selected in the left pane. 

Plant Applications Web Server Client 

The left pane of the two-pane display shows the reports and web content available to the 
current user. 

Select a report definition or web content to display the information in the right pane. Select a 
report type to display the report dialog boxes in the right pane. 

Use a browser to access the Plant Applications Web Server client from a URL: 

https://<server>/PAReporting  



 

Legend: 

1. Lists the Web Reports and Web Parts available to the user. 

2. Web Server toolbar. 

3. Web Report or dialog boxes for creating the selected Web Report. 

 

 

 

Web Part Administrator 

Use the Web Part Administrator to configure and manage Web Parts, create new Web Parts, 
change default parameters, and access a variety of statistical reports. 

Expand Server Management in the Plant Applications Administrator tree, then double-click 
Administrator Web Parts to open the Web Administrator. 



 

Legend: 

1. The Manage tab lists the templates used to create user-defined Web Parts. Use 
the Configure tab to set up Web Parts. 

2. Lists of Web Parts or Web Part templates and information about each Web Part or template. 

3. Click to import or export Web Parts and Web Part templates. 

4. Click to preview the selected Web Part or Web Part template. 

5. Click to specify parameters that control properties such as the placement of your Web Part 
or Web Part template in your portal. 

6. Click to create new Web Part templates, and to copy or delete existing templates. 

7. Provides information about the selected Web Part or Web Part template. You can also use 
the tabs to edit the default parameters for the associated Web Part or template. 

Plant Applications REST APIs 



The Plant Applications UCC provides a Swagger-based UI to view and run the Representational 
State Transfer (REST) APIs. 

You can access the UI from the list of supported Web browsers by entering a URL in the 
following 
format: https://<server_name>:<port_number>/<micro_service_name>/swagger
-ui.html. 

Where: 

• <server_name>: Represents the name of the server on which the Plant Applications 
universal client is installed. 

• <port_number>: Represents the network port used by the Plant Applications universal 
client. 

• <micro_service_name>: Represents the name of the microservice for which you 
want to run the REST APIs. The microservice and the corresponding applications 
where you can run the microservice are listed in the following table. 

Microservice Applications 

productionmetrics-service • Equipment 

• Reports 

productionmetrics-app-service 

• Equipment 

• Reports 

processanalyzer-service-impl-0.6.1 Analysis 

mes-dataservice-impl-0.6.1 Analysis 

activities-service-0.5.1 Activities 

activities-app-service-impl-0.1.0 Activities 



IMPORTANT: 

The following REST API microservices are deprecated from Plant Applications 8.0. These REST API 

microservices will be permanently removed in the future release. 

• In activities-service: 

• GET /userDefined/v1/events/{eventId}/status 

• GET /production/v1/events/{eventId}/status 

• In comment-service: 

• GET /comment/v1/commentThreads/permissions 

Access the Plant Applications REST APIs 

1. Open a web browser. 

2. Enter the URL for a Swagger-based UI in the following 
format: https://<server_name>:<port_number>/<micro_service_name>/swagg
er-ui.html. 

For example, https://www.ge.com:443/activities-app-service-impl-
0.1.0/swagger-ui.html 

The UI for the specified microservice appears. 

3. Select Authorize. 

The Available authorizations window appears. 

4. In the client_id box, enter the clientId for the Plant Applications universal client server. 

5. In the client_secret box, enter the client secret for the Plant Applications universal client 
server to authorize requests to expose the REST API endpoints. 

You can now view and run the REST APIs for the selected microservice. 

Verifying Plant Applications Service Startup 

After installing the Plant Applications Server, the Plant Applications Server services should start 
automatically. 

Verify that the Plant Applications Server services have started. 



1. Open the Windows Control Panel, and double-click Administrative Tools. 

2. Double-click Services. 

3. Scroll through the list of services and verify that the Plant Applications Server services have 
all started. If they have not started, start them manually. 

Another method for verifying that the Plant Applications Server services have started is to 
view the server log files. These text files are created during the Plant Applications Server 
installation. Each service has its own log file. By default, the log files are located on the Plant 
Applications Server in the following directory: 

C:\<Program Files>\Proficy\Proficy Server\LogFiles 

Verifying the Server Connection 

When using Plant Applications, the connection to the server can be lost for a number of 
reasons. 

1. Start Plant Applications Administrator and log in with username comxclient and 

password comx. 

2. Start Plant Applications client and log in with username comxclient and password comx. 

3. Start Microsoft Excel. 

4. Load the Plant Applications Add-in for Excel, click Tools > Add-ins > Plant Applications Excel 
Add-in. 

5. Connect to the Plant Applications Server. For more information, see Connecting to a 
Server topic in the online help for the Add-in. 

Changing the SharePoint Port Number 

SharePoint Services 3.0 uses port 80 by default, which is the port used by the Plant 
Applications Web server. 

You must change the port used by SharePoint: 

1. On the Plant Applications Web server, select Start > Administrative Tools > Internet 
Information Services (IIS) Manager to open Internet Information Services (IIS) Manager. 

2. Expand the server and expand Web Sites. 



3. Right-click SharePoint - 80, then select Properties. 

The SharePoint – 80 Properties dialog box appears. 

4. Under web site identification on the Web Site tab, enter an unused port number in the TCP 
Port field. Click OK. 

5. Right-click SharePoint Central Administration v3, then select Browse to display 
the SharePoint Central Administrationpage. 

6. Select the Operations tab and select Alternate access mappings under Global 
Configurations. 

7. Under Internal URL, select the URL for the server (for 
example: http://<myservername>/). 

8. In the URL protocol, host and port field, append the port number used in step 5 to the end of 
the computer name. For example: http://<myservername>:85/. 

9. Click OK and, if necessary, start the Default Web Site. 

NOTE: 

 Add the port number to the SharePoint URL. For example, if you used port 81, the URL would 
be: http://<myservername>:81. 

Backing Up and Restoring an SQL Database 

You can use an SQL Server database as the Plant Applications database or Unified 
Manufacturing Database (UMDB). 

You must back up and restore an SQL Server database. 

1. Back up the database on the SQL Server instance. 

See How to create a database backup (Enterprise Manager) in the SQL Server Books Online. 

2. Make a copy of the backup file. 

Because SQL Server Management Studio does not allow restoration from a network location, 
the backup file must be copied to the local disk of the SQL Server instance. 

3. Restore the database to the SQL Server instance. 

See How to: Create a New Database from an Existing Database Backup (SQL Server 
Management Studio in the SQL Server Books Online. 



4. After the database has been restored, ensure that permissions are set up correctly in 
the Plant Applications database. From SQL Server Management Studio, run the following 
script to rebuild the SQL permissions 

exec sp_Revokedbaccess 'ProficyDBO'  

         go  

         exec sp_Revokedbaccess 'ComXClient'  

         go   

         exec sp_Revokedbaccess 'ProficyConnect' 

         go  

         exec SpSupport_ChangeDBOAccount 'Proficydbo','ProficyDBO' 

Moving Database and Log Files 

After installing the Plant Applications Server, you can move the Plant Applications or Unified 
Manufacturing Database (UMDB) database file and log file to a separate physical disk to 
optimize performance. 

The physical disk should be part of the disk subsystem, 

NOTE: 

• For more information on optimizing SQL Server performance, contact Support at Support. 

• If upgrading SQL Server to a newer version, run sp_revokeDBAccess for ProficyDBO, 
ComxClient, and ProficyConnect. Next, run spSupport_ChangeDBOAccount to 
reconfigure the SQL User Accounts. 

An SQL Server database consists of MDF (database file) and LDF (log file) files. By default, these 
two files are located in the following directory: 

C:\Program Files\Microsoft SQL Server\MSSQL\Data 

1. Locate the MDF and LDF files. 

a. Start SQL Server Management Studio from the Windows Start menu. 

b. Navigate to the database, right-click it, then select Properties to display the Database 
Properties dialog box. 

c. Under Select a page, right-click Files to view the location of the MDF and LDF files. 

2. Stop the following Plant Applications Server services: 

https://apps-docsstaging.predix.io/en-US/content/manufacturing_solutions/plant_applications/plant_applications_getting_started_guide/general-contact-information#concept_f39c7423-9ff1-46e8-9f90-e6afb1d4a595


• Proficy Server Manager 

• Proficy Server Router 

• Proficy Server License Manager 

3. Stop the Proficy Server, Proficy Publisher, and Proficy STS Services used for SOA. 

4. In SQL Server Management Studio, take the database offline. 

 . Select Plant Applications SQL Server, then select Databases. 

a. Right-click the Plant Applications database, select Tasks, and then select Take Offline. 

5. Detach the database (refer to SQL Server documentation). 

6. Copy the MDF and LDF files to the SQL Server instance. 

7. Attach the database to the SQL Server instance. 

8. Bring the database online, then verify the location of the MDF and LDF files. 

9. Restart the Plant Applications Server and SOA services. 

10. After the database has been restored, verify that permissions are set up correctly in 
the Plant Applications database. From SQL Server Management Studio, run the following 
script to rebuild the SQL permissions: 

exec sp_Revokedbaccess 'ProficyDBO'Plant Applications 

go 

exec sp_Revokedbaccess 'ComXClient' 

go 

exec sp_Revokedbaccess 'ProficyConnect' 

go 

exec SpSupport_ChangeDBOAccount 'Proficydbo','ProficyDBO' 

 

 

 

Proficy Router Conflicts 



By default, Plant Applications uses port 12280, which is occasionally used by other software. 
This can cause communication conflicts causing the Plant Applications Server to disconnect 
from the Proficy Router. 

The following four files must be edited on the Plant Applications Server: 

• cmConfigMgr.ini 

• cmRtr.ini 

• Message.ini 

• PlantAppsMessaging.ini 

You must change the port used by Plant Applications. 

1. On the Plant Applications Server, navigate to <drive>:\Program 
Files\Proficy\Proficy Server\Messaging. By default, this directory is on 
the C: drive. 

2. Using a text editor, open each of the INI files. 

3. Locate the following line: Protocol0_Item0 = 12280. 

4. Change 12280 to an unused port number. You must use the same port number in each of 

the four files. 

5. Save the file. 

6. After you update all the files, restart the Plant Applications Server. 

SQL Login Conflicts 

When installing the Plant Applications Server, if the SQL user information cannot be validated, 
the installation program generates an error message. 

Upon failing to validate the SQL user account, the installation program displays the following message 

before returning to the login validation screen: 

Database Install Fatal Error encountered: Invalid SQL Username a

nd Password Install aborted.  

The error indicates a configuration conflict in the registry with the ADO Connection string used 
to instantiate a connection to the SQL Server. If the Plant Applications Server had been 
previously installed with a different server name, the DatabaseNodeNameregistry key may 
be pointing to an invalid SQL Server. 



To resolve the error, open REGEDIT and validate that the String Value <databasenodename> exists 

in the following locations: 

• HKey_LocalMachine\Software\Proficy\Plant 

Applications\Proficy Server 

• HKey_LocalMachine\Software\MountainSystems\Proficy\Proficy 

Server\DataBaseNodeName 

Runtime Error 

Plant Applications Server or Common Licensing installation fails upon encountering a pre-
existing installation. 

This error typically occurs on machines that have Terminal Services enabled and where you are 
running a compressed setup that is not named setup.exe. The error occurs because the 
operating system fails to return the correct Fonts system folder, which causes 
a setup.exe exception during initialization. 

In most cases, the operating system uses C:\Documents and Settings\\Windows, 
instead of a real Windows folder, and does not include a Fonts subfolder. The operating 
system fails when attempting to locate the Fonts subfolder. Refer to MSDN for additional 
information. 

• Rename the single executable file to setup.exe, and run the installation again. 

• Disable Terminal Services on the machine, and re-run the installation. 

• Replace the compressed, single executable with a full DVD release. 

• Run the installation from Add/Remove Programs rather than launching the installation 
directly. Create the Fonts folder in the location where the setup is checking under 
the current user at Documents and Settings\\Windows\Fonts. 

SQL Server Blockage 

The Plant Applications SQL Server can fail when running at the same time as an Online-
Transaction Processing (OLTP) application and a reporting database. 

Because SQL transactions are typically small for OLTP applications, a common practice is to 
disable parallelism to minimize conflicts between different processe. To improve the response 
of large complex reporting queries however, it is generally recommended to maximize 
parallelism. If the Plant Applications SQL Server starts to experience a significant amount of 



blocking that affects the timely interaction of Plant Applications with operators and control 
systems, reducing or disabling the parallelism option may alleviate the issue. 

You should initially restrict the SQL Server parallelism option it to use half the number of 
processors available. If not adequate, try disabling parallelism altogether by setting the option 
to 1 so that one processor is used for a given query. For more about max degree of 

parallelism option, see the SQL Server documentation. 

1. In SQL Server Management Studio, right-click the server, then click Properties to display 
the Server Properties dialog box. 

2. Under Select a page, click Advanced to display the Advanced page. 

3. Under Parallelism, edit the Max Degree of Parallelism value. The default is 0 (zero), which 
uses the actual number of available processors. 

Option Description 

Edit Recommended value: half the number of processors on the server. 

1 Disables the option. 

4. Click OK. 

License Server Startup Failure 

The Plant Applications Server License Manager service may not start due an incorrect database 
password stored in the registry. 

As the Proficy Server License Manager service is used to change the password, you must reset 
the database passwords to correct this issue. 

1. Set the proficydbo password to the default password, proficydbo, in SQL Server. 

2. Set the comxclient password to the default password, comxclient, in SQL Server. 

3. Delete the encrypted passwords from the registry: 



• HKEY_LOCAL_MACHINE\SOFTWARE\Proficy\Plant 

Applications\Proficy Server\DBParam1 

• HKEY_LOCAL_MACHINE\SOFTWARE\Proficy\Plant 

Applications\Proficy Server\DBParam2 

4. Start Proficy Server License Manager to initialize the registry to the default. 

5. Reset the password using the Administrator. 

Web Content Issues 

If you are having difficulty viewing the web content tree or you are receiving errors when you 
try to view the tree in a web client, you may need to enable parent paths for 
the PAReporting virtual directory. 

NOTE: 

 ASP.NET is required to log into the Web Report server. 

1. Open Internet Information Services (IIS) Manager and expand the server. 

2. Right-click the PAReportingvirtual directory, then click Properties. 

The PAReporting dialog box appears. 

3. On the Virtual Directory tab, click Configuration. 

The Application Configuration dialog box appears. 

4. On the Options tab, select Enable parent paths. 



 

5. Click OK twice to return to the Internet Information Services window. 

6. Close the Internet Information Services window. 

Web Reports Issues 

If the Plant Applications Web Reports are not working correctly, you may need to enable HTTP 
Keep-Alives. 

For information about installing and using SSRS, refer to the Proficy Plant Applications SSRS 
Report Configuration and Report Creation Guide, which is posted in KB16011. 

1. In the Internet Information Services (IIS) Manager, locate the local computer. 

2. Expand Web Sites, right-click the website, and then select Properties. The Properties dialog 
box for the web site is displayed. 

3. On the Web Site tab, click Connections and ensure Enable HTTP Keep-Alives is selected. 

4. Click OK. 



Proficy Server Shutdown Error 

When stopping the Proficy Server, the system can generate a 1067 error message indicating 
that the process terminated unexpectedly. This error can be ignored. 

Click OK, then confirm that the status of the service is no longer started. 

Proficy Server Installation Script Failure 

Proficy Server installation can fail when the scripts utility cannot log in with authentication for 
the previously installed version. 

When the SQL script cannot run, the installation script generates the following message: 

Script Execution- Login Failed 

As a workaround, set the sa user login to a blank password in SQL Server Management Studio. 

Database Connection Failure 

After installation, the system displays a failed to connect to database 
server message when starting the Plant Applications Administrator or client. 

NOTE: 

 If the server appears in the list of Plant Applications Servers in the Plant Applications Administrator, 

double-click the server name to display the list of nodes. 

 



1. Verify that the Proficy Licensing and Proficy Server License Manager services are running. If 
not, start the services. Restart the Plant Applications Administrator or Client to see if it 
connects to the database. 

2. If you are still unable to connect to the database, register the following controls using the 
command line: 

• Regsvr32 “C:\<Program Files location>\Common 

Files\Proficy\Plant Applications\PRMsgs.dll” 

• Regsvr32 “C:\<Program Files location>\Common 

Files\Proficy\Plant Applications\ProfCDG.ocx” 

• Regsvr32 “C:\<Program Files location>\Common 

Files\Proficy\Plant Applications\ProfSVR.dll” 

• Regsvr32 “C:\<Program Files location>\Common 

Files\Proficy\Plant Applications\PRUtils.dll” 

NOTE: 

 The Program Files location varies depending on whether the operating system is 32- or 64-bit. 
For a 64-bit operating system, the path is Program Files (x86). For a 32-bit operating system, 

the path is Program Files. 

License Manager Connection Failure 

The License Manager depends on the ProficyConnect database user. 

If the Proficy Server Router log file indicates that it is waiting for the license manager connection and the 

license is installed correctly as confirmed through the License Viewer, the database users are likely not 

synchronized. 

To check whether database users are synchronized, connect to the database (for example, 
SOADB) using SQL Server authentication with ProficyConnect as the user and proficy as 
the password. If the connection attempt fails, you must fix the database users. 

1. Stop the following services: 

• Proficy Server Manager 

• Proficy Server Router 

• Proficy License Manager 

2. Connect to the SQL server as sa, under the main Security\Logins branch, then delete 
the ComXClient, ProficyConnect, and Proficydbo users. 



3. Run the following command as a database query: 

exec spSupport_ChangeDBOAccount 

4. Restart the Proficy License Manager and Proficy Server Manager services. 

All the services controlled by Proficy Server Manager should start up. 

Proficy Workflow Client Startup Failure 

If the Workflow client does not start: 

• Verify that all related services, including the licensing and Proficy Server services, are 
running. 

• Stop and restart the services if necessary. 

Plant Applications Client or Administrator Failure 

This procedure is applicable if you installed GE Proficy Historian Server 7.1 on the same node as 
Plant Applications. 

1. Verify whether the Historian is uninstalled. 

2. Reinstall the Historian on the same node as Plant Applications. 

  



Test and Production Environments 

Environment Overview 

Installing Plant Applications involves installing several different servers that communicate with 
each other. 

The servers can be installed on one computer for testing, or they can be distributed in a 
network to create production environments. Before installing the software for a new 
installation, decide what your environment will be and what its architecture will look like. 

A list of prerequisite software for Plant Applications 8.0 is included in the Preparing to Install 
Plant Applications section. For information about using Plant Applications in a clustered 
environment with Microsoft server failover technology for highest availability of the Plant 
Applications Server, see Appendix B: Cluster Installation and Configuration. 

Test Environment 

A simple Plant Applications installation employs a single computer for testing. In most cases, 
this environment is not suitable for production, because the architecture does not scale well. 
However, it may be satisfactory for very low-frequency and low-transaction environments. 

 



Test Environment Checklist 

Your environment should include the following installed or upgraded software: 

• Supported version of Microsoft Windows Server. 

• Latest service pack update (Windows update). 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0. 

• Microsoft .NET Framework 3.5 for Workflow 2.6. 

• SQL Server 2012 Native Client 11.4.7001.0. 

• IIS 8.0 or higher with ASP.NET and FTP for Plant Applications Web Reports. Configure 
the HTTPS binding if required. If necessary, uninstall WebDAV Publishing. 

• Supported browser. Plant Applications legacy reports and web parts are not supported 
in Chrome. 

• Microsoft Office with Excel for SQL Server and Web Engines. 

• SQL Server and latest service pack. 

• Hardware key and software licenses. 

• Proficy Application Server and Web Server, which installs Workflow. 

• Plant Applications Server software. 

• Plant Applications Report (Web) Server software for Web Server reports. 

• SSL Security Certificates. 

• Plant Applications client applications. 

• Historian or another historian, and all service packs. 

Standard Production Environment 

A standard production environment representing the most common architecture for 
production sites to deliver performance is shown in the image below. 

Install the following servers and components on separate computers: Plant 
Applications Server, Plant Applications Report Server (Web Server) reports, historian, and 



clients. Although the Plant Applications Server and a Web Server can be installed on the same 
machine, performance may be affected. 

 

Unified Manufacturing Database (UMDB) 

• Supported version of Microsoft Windows Server. 

• SQL Server. 

• Microsoft .NET Framework 3.5. 

Proficy Plant Applications Server Computer 

Your environment should include the following installed or upgraded software. 

• Supported version of Microsoft Windows Server. 

• Latest service pack update (Windows update). 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0. 

• Microsoft .NET Framework 3.5 for Workflow 2.6. 

• SQL Server 2012 Native Client 11.4.7001.0. 

• IIS 8.0 or higher with ASP.NET and FTP for Plant Applications Web Reports. Configure 
the HTTPS binding if required. Ensure WebDAV Publishing is uninstalled. 

• Microsoft Office with Excel for SQL Server and Web Engines. 



• Hardware key and software licenses. 

• Proficy Application Server which installs Workflow components. 

• Plant Applications Server software. 

Plant Applications Report (Web) Server 

• Supported version of Microsoft Windows Server. 

• Latest service pack update (Windows update). 

• Microsoft Office with Excel for Web Engines. 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0. 

• Microsoft .NET Framework 3.5 for Workflow 2.6. 

• SQL Server 2012 Native Client 11.4.7001.0. 

• IIS 8.0 or higher with ASP.NET and FTP for Plant Applications Web Reports. Configure 
the HTTPS binding if required. Ensure WebDAV Publishing is uninstalled. 

• Plant Applications Report (Web) Server software for Web Server reports. 

• SSL Security Certificates. 

• Supported browser. Plant Applications legacy reports and web parts are not supported 
in Chrome. 

• Install additional components: 

Once software is installed, you need to create Services user accounts to start with their own 
Windows user account and apply the Login As Service policy. 

Historian Server 

• Windows Server (refer to Historian documentation for version requirements). 

• Refer to Historian documentation for system requirements and software configuration. 

• Historian or another historian, and all service packs. 



Plant Applications Administrator Computer 

These requirements typically apply to the client computer as well. 

• Supported version of Microsoft Windows Server. 

• Latest service pack update (Windows update). 

• Microsoft Office with Excel. 

• SQL Server and latest service pack. 

• Plant Applications Administrator. 

• Supported browser. Plant Applications legacy reports and web parts are not supported 
in Chrome. 

• Plant Applications UI support in Workflow Client: 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0. 

• Microsoft .NET Framework 3.5 for Workflow 2.6. 

• SQL Server 2012 Native Client 11.4.7001.0. 

• IIS 8.0 or higher with ASP.NET and FTP for Plant Applications Web Reports. 
Configure the HTTPS binding if required. Ensure WebDAV Publishing is 
uninstalled. 

• Proficy Application Server which installs Workflow. 

Plant Applications Client Computers 

• Supported version of Microsoft Windows Server. 

• Latest service pack update (Windows update). 

• Plant Applications Client. 

OperationsHub UAA 

• Supported version of Microsoft Windows Server or Client. 



• Latest service pack update (Windows update). 

• Microsoft .NET Framework 4.7 for Plant Applications 8.0. 

Plant Applications Universal Client Computer 

• Supported version of Microsoft Windows Server or Client. 

• Microsoft .NET Framework 4.7 for Plant Applications Universal Client 8.0. 

High-Volume Production Environment 

In a high-volume production environment with a high number of transactions or a high 
reporting volume, Plant Applications web engines can be installed on separate machines to 
increase performance throughput. 

High-production environments can also employ Plant Applications installations on multiple 
machines. The following image shows an example of a high-volume production environment 
for Plant Applications. 

 

SOA services reside on the Proficy Server, which is also called the Plant Applications Server. 

  



Appendix B: Cluster Installation and Configuration 

Cluster Overview 

Deploying Plant Applications in a clustered environment with Microsoft server failover cluster 
technology ensures the highest availability of the Plant Applications Server. For example, if the 
primary Plant Applications node in the cluster experiences difficulties, Plant 
Applications automatically starts on another node to take over. SQL Server, a historian, and 
the Plant ApplicationsWeb (Report) Server can also run as part of a cluster. Refer to Microsoft 
documentation for information to implement clustering for your particular environment. 

System Requirements 

To deploy Plant Applications in a clustered environment, you will need at least two cluster 
nodes. All the cluster nodes must be assigned to the same domain name, and must contain the 
following components: 

• Windows 2012 r2 server with the same service pack versions installed on them. 

• Feature Failover Clustering 

• An active Proficy license 

• Proficy Workflow 

• Plant Applications 

• iSCSI Target Server, serving as a remote drive for Plant Applications Buffer Files and Log 
Files 

Deploy Plant Applications in a Clustered Environment 

Perform the following steps on each cluster node: 

• Access the iSCSI Initiator Properties window, and provide the address of an iSCSI target. 

• Create a storage for iSCSI by performing the following steps: 

1. Access the Failover Cluster Manager window, and then select the cluster node. 

2. Select Storage > Disks > Add Disk. 



3. Select iSCSI. 

• Create a Plant Applications role by performing the following steps: 

1. Access the Failover Cluster Manager window, and then select the cluster node. 

2. Select Roles > Create Role > Other Server. 

3. Set the NetBios name of the Plant Applications server. 

4. Right-click the shared drive, and then select Assign to Role > Pick PA Cluster role 
up. 

• Configure Workflow in a clustered environment by performing the steps provided in the 
following article: https://digitalsupport.ge.com/communities/en_US/Article/To-Build-
Proficy-Workflow-Cluster 

• Configure the Proficy Certificate service by performing the following steps: 

1. Access the Proficy Certificate Properties window. 

2. Select General. 

3. From the services of type Generic Service, select Proficy Ceritificate. 

1. Access the Add Roles and Features Wizard window, and then select Features. 

2. Expand Remote Server Administration Tools and then Feature Administration Tools. 

3. Select all the check boxes for Failover Clustering Tools. 

4. Create a Plant Applications resource type by accessing the Command Prompt and running 
the following commands: 

Regsvr32 "<Plant Applications installation folder>\Proficy 

Server\Server\PlantAppsResEx.dll" /s 

Cluster restype PlantAppsRes /create /dll:"<Plant Applications 

installation folder>\Proficy Server\Server\PlantAppsRes.dll" 

/type:PlantAppsRes /LooksAlive:5000 /IsAlive:30000 

5. Access the following file: <Plant Applications installation 
folder>\Proficy Server\Server\ClusterConfigurator.exe 

The Plant Applications Cluster Configurator window appears. 

6. Select Add resource to cluster, and then select Next. 



The New Resource window appears. 

7. In the Resource type and Group boxes, select Server and the cluster node, respectively, and 
then select Next. 

The Possible Owners window appears. 

8. Add the cluster nodes in the Available nodes section to the Possible owners section, and 
then select Next. 

The Advanced window appears. 

9. Select Restart > Affect the group, and then enter 3 and 900 in 
the Threshold and Period boxes, respectively. 

10. In the "Looks Alive" poll interval and "Is Alive" poll interval sections, select the Use value 
from resource type check boxes. 

11. Select Finished. 

12. Perform steps 1 through 11 for all the cluster nodes. 

Plant Applications is deployed on a clustered environment. 

• For each cluster node, ensure that the following registry key is set to the Plant 
Applications Cluster NetBios 
name: Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Prof
icy\Plant Applications\Proficy Server\LicenseMgrNode 

• Change the Plant Applications server name in the Microsoft SQL database to the Plant 
Applications cluster node name by running the following 
command: spSupport_UpdatePAServerReferences_Split <old server 
name> <Cluster NetBios name> 

• Change the path of the Plant Applications log files and buffer files to that of the cluster 
nodes shared drive by running the following commands: 

Select * from dbo.Site_Parameters where parm_id in (101, 102) 

Select * from dbo.User_Parameters where parm_id in (101, 102) 

 

Select * from dbo.Site_Parameters where parm_id in (101, 102) 

Select * from dbo.User_Parameters where parm_id in (101, 102) 

 

UPDATE Site_Parameters  



SET Value = '<cluster node shared drive path to log files>' 

WHERE parm_id = 101 

 

UPDATE Site_Parameters  

SET Value = '<cluster node shared drive path to buffer files>' 

WHERE parm_id = 102 

 

UPDATE User_Parameters  

SET Value = '<cluster node shared drive path to log files>' 

WHERE parm_id = 101 

 

UPDATE User_Parameters  

SET Value = '<cluster node shared drive path to buffer files>' 

WHERE parm_id = 102 

• Ensure that Plant Applications Manager does not control the Plant Applications services 
by running the following command: 

Update dbo.CXS_Service  

Set Auto_Start = 0, Auto_Stop = 0, Restart_Non_Responding = 0 

where Service_Id between 2 and 25 

• Modify the following files to adjust route group and domain name to the cluster name 
and to adjust log files and buffer files path to a shared drive: 

• cmRtr.ini 

• PlantAppsMessaging.ini 

• cmConfigMgr.ini 

• Message.ini 

• Set the site parameter ClusteredSystem to true by running the following command: 

Select * from dbo.Parameters where Parm_Name like '%Cluster%' 

Select * from Site_Parameters where Parm_Id = 131 

Update Site_Parameters 

Set Value = 1 



Where Parm_Id = 131 

Upgrading from Version 6.3 or 7.0 

Upgrading from Plant Applications Version 6.3 or 7.0 to 8.0 

Delete the existing Message Bridge configuration file located at <Plant Applications 
installation folder>\Proficy 

Server\RabbitMQMessageBridgeService\Proficy.PlantApps.MessageBridge.Se

rvice.exe. This is because installing Plant Applications does not replace the old configuration file 

with the new one. 

NOTE: 

 If upgrading from a version of Plant Applications earlier than 6.3, contact Support to uninstall Plant 

Applications components. 

1. From the Windows Start menu, select Control Panel > Programs > Programs and Features. 

2. Uninstall programs in the following order. 

a. Proficy Plant Applications Client 

b. Proficy Plant Applications Web Server 

c. Proficy Plant Applications Server 

d. Proficy Vision. If this fails, try again. 

e. Proficy Workflow (For 64-bit components) 

f. Proficy Workflow (Full Server) 

3. On the SQL Server Management Studio delete the following: 

• Databases: KSPWork, and KSP. 

• User Account: KSPUser 

• Verify that the Close existing connections checkbox is selected. 

4. From Windows Explorer, delete the following directories. 

• C:\Program Files\Proficy\Proficy Workflow 

• C:\Program Files (x86)\Proficy\Proficy Workflow 



5. From Internet Information Services (IIS) Manager, delete the following virtual directories. 

• Apps 

• PAReporting 

• ProficyDashBoard 

• ProficyWebParts 

• Reports 

6. If you have installed Service Packs or SIMs from Plant Applications, you must edit the 
REGISTRY (regedit) to delete all the SIM entries. Go 
to <HKEY_LOCAL_MACHINE> > Software > Wow6432Mode > Microsoft > Windows > <curre
nt version> > Uninstall. 

Sample SIM entries: 

 

7. Upgrade the Proficy license keys to include: 

• Plant Applications 8.0 

• Historian 7.1 



• SOA/Workflow 2.6 

8. Go to Server Manager > Local Server > Tasks > Add Roles and Features. 

Add the following Roles: 

• Go to Web Server (IIS) > Web Server > Common HTTP Features and select HTTP 
Redirection checkbox. 

• Go to Web Server (IIS) > Web Server > Security and select Basic 
Authentication, URL Authorization and Windows Authentication checkboxes. 

Add the following features: 

• Go to .NET Framework 4.7 Features > WCF Services and select the HTTP 
Activation feature. 

9. Start the SQL Server Agent service manually. 

10. Use the following procedures to complete the upgrade. 

• Installing the Proficy Application Server 

• Installing the Plant Applications Server 

• Installing the Plant Applications Report Server 

• Installing the Plant Applications Client and Administrator 

• Installing the Plant Applications Message Bridge 

• Installing the Plant Applications Universal Client 

  



Getting Assistance 

General Contact Information 

If you purchased this product through an Authorized Channel Partner, contact the seller 
directly. 

Technical Support 

If you have technical problems that cannot be resolved using this guide, contact us by 
telephone, email, or on the web at https://digitalsupport.ge.com/. 

https://digitalsupport.ge.com/
https://www.ge.com/digital/products
https://digitalsupport.ge.com/
https://digitalsupport.ge.com/CC_Contact
mailto:%20digitalsupport@ge.com



